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This is the safety alert symbol. It is used to alert you to potential personal
IMPOR TANT injury hazards. Obey all safety messages that follow this symbol to avoid
possible injury or death.

. DANGER—Indicates a hazardous situation which, if not avoided, will result in death

or serious injury.

WARNING—Indicates a hazardous situation which, if not avoided, could result in

death or serious injury.

. CAUTION—Indicates a hazardous situation which, if not avoided, could result in
minor or moderate injury.

. NOTICE—Indicates a hazard that could result in property damage only (including
damage to the control).

. IMPORTANT—Designates an operating tip or maintenance suggestion.

DEFINITIONS

The engine, turbine, or other type of prime mover should be equipped with an
overspeed shutdown device to protect against runaway or damage to the prime
mover with possible personal injury, loss of life, or property damage.

The overspeed shutdown device must be totally independent of the prime mover
control system. An overtemperature or overpressure shutdown device may also
be needed for safety, as appropriate.

installing, operating, or servicing this equipment. Practice all plant and safety instructions and

f Read this entire manual and all other publications pertaining to the work to be performed before
precautions. Failure to follow instructions can cause personal injury and/or property damage.

you have the latest revision, be sure to check the publications page on the Woodward website:
www.woodward.com/searchpublications.aspx
The current revision and distribution restriction of all publications are shown in manual 26311.

f This publication may have been revised or updated since this copy was produced. To verify that

The latest version of most publications is available on the publications page. If your publication is
not there, please contact your customer service representative to get the latest copy.

electrical, or other operating limits may cause personal injury and/or property damage, including
damage to the equipment. Any such unauthorized modifications: (i) constitute "misuse" and/or
"negligence" within the meaning of the product warranty thereby excluding warranty coverage
for any resulting damage, and (ii) invalidate product certifications or listings.

To prevent damage to a control system that uses an alternator or battery-charging
NO TICE device, make sure the charging device is turned off before disconnecting the battery

from the system.

To prevent damage to electronic components caused by improper handling, read
NO TICE and observe the precautions in Woodward manual 82715, Guide for Handling and

Protection of Electronic Controls, Printed Circuit Boards, and Modules.

f Any unauthorized modifications to or use of this equipment outside its specified mechanical,

I Revisions—Text changes are indicated by a black line alongside the text.

Woodward reserves the right to update any portion of this publication at any time. Information provided by Woodward is
believed to be correct and reliable. However, no responsibility is assumed by Woodward unless otherwise expressly
undertaken.
© Woodward 2013
All Rights Reserved
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Regulatory Compliance

European Compliance for CE Marking:

No units bear the CE mark. There is no declaration of conformity for the control.
The control is intended to only be integrated into engine systems as a component
of the larger system. The control is not sold separately except as spare parts for
repair of existing systems.

Compliance to EMC Standards:

The EMC, Electro-Magnetic Compatibility, with the control’s environment has
been addressed via a combination of mostly ISO automotive standards and
similar EN’s. Due to the application environments, limited use vehicle
requirements EN 13309 and EN 14982 are the most applicable product family
standards. The harmonized standards for Generic Immunity & Emissions of
heavy industrial products (EN 61000-6-2 & EN 61000-6-4) were only used as
supplemental to EN 13309, EN 14982, ISO 11452-2, ISO 11452-4 and ISO
7637-2. Transient pulses of ISO 7637-2, instead of those originally called out in
EN/ISO 14982 and EN 13309, were used.

The serial communication port is intended as a service port only. It
IMPORTANT may only be connected as a configuration and tuning tool, then
disconnected during normal operation.

The CAN J1939 communication port is not intended for critical
communications and is only provided as limited use port, such as
reading values form the APECS 4500 as a service port. CAN must
only be used for messages that monitor control status or set non-
critical control values. CAN communication may not be a
determinative portion of the control loop.

The unit has degraded performance on the internal actuator current
IMPORTANT feed back when subject to 100 V/m in the 443-452 MHz range.
Performance is just outside normal and returns to normal by
dropping the level 1 dB or to ~90 V/m. 32 V/m is the typical
automotive sub-component requirement called in the standards
above. The read back deviations at 100 V/m do not affect
performance of the control.

The unit must use some form of pulse suppression external to the
IMPORTANT control and on power bus to allow for connection to:
e A distributed DC mains

e An unsuppressed alternator (>100 Vp load dump)
e A wiring harness having parallel unsuppressed inductive loads

iv Woodward
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Electrostatic Discharge Awareness

All electronic equipment is static-sensitive, some components more than others.
To protect these components from static damage, you must take special
precautions to minimize or eliminate electrostatic discharges.

Follow these precautions when working with or near the control.

1. Before doing maintenance on the electronic control, discharge the static
electricity on your body to ground by touching and holding a grounded metal
object (pipes, cabinets, equipment, etc.).

2. Avoid the build-up of static electricity on your body by not wearing clothing
made of synthetic materials. Wear cotton or cotton-blend materials as much
as possible because these do not store static electric charges as much as
synthetics.

3. Keep plastic, vinyl, and Styrofoam materials (such as plastic or Styrofoam
cups, cup holders, cigarette packages, cellophane wrappers, vinyl books or
folders, plastic bottles, and plastic ash trays) away from the control, the
modules, and the work area as much as possible.

4. Do not remove the printed circuit board (PCB) from the control cabinet
unless absolutely necessary. If you must remove the PCB from the control
cabinet, follow these precautions:

e Do not touch any part of the PCB except the edges.

. Do not touch the electrical conductors, the connectors, or the
components with conductive devices or with your hands.

e  When replacing a PCB, keep the new PCB in the plastic antistatic
protective bag it comes in until you are ready to install it. Immediately
after removing the old PCB from the control cabinet, place it in the
antistatic protective bag.

To prevent damage to electronic components caused by improper

NO TICE handling, read and observe the precautions in Woodward manual
82715, Guide for Handling and Protection of Electronic Controls,
Printed Circuit Boards, and Modules.

Woodward Y,




APECS 4500 Electronic Engine Speed Governing System Manual 36752D

Vi Woodward



Manual 36752D APECS 4500 Electronic Engine Speed Governing System

Chapter 1.

General Information
]

System Basics

APECS® is an acronym for Advanced Proportional Engine Control System. It
provides a means of controlling engine speed by adjusting the fuel control lever
with an actuator. The heart of the system is a powerful microprocessor-based
controller that processes the signal received from a speed sensor and compares
it to the desired speed setting.

The output of the controller is a pulse-width modulated signal that drives a
precision proportional actuator connected to the engine’s fuel control lever. The
actuator converts the signal to an output shaft position, proportional to the duty
cycle of the pulse-width modulated signal.

The APECS system provides isochronous engine governing (i.e., engine speed
is maintained at the commanded setting, regardless of load) through a wide
speed range. APECS is suitable for use on both compression ignition (diesel)
and spark ignition (gasoline, CNG, LPG) engines.

Woodward developed the APECS system for a variety of off-highway applications.
Typical applications include generator sets, compressors, construction machinery
and farm vehicles.

| The engine, turbine, or other type of prime mover should be
equipped with an overspeed shutdown device to protect against
runaway or damage to the prime mover with possible personal injury,
loss of life, or property damage.

The overspeed shutdown device must be totally independent of the
prime mover control system. An overtemperature or overpressure
shutdown device may also be needed for safety, as appropriate.

Engine zpeed =ignal ENGINE PROPORTIONAL
=peen | [FUEL ACTUATOR
e [PUMEOR
g: SENSOR y F:-:-'l'rLE:E I
—
i o i (T e
Speed setpoint switches > PN Output J_Ll_L
Analog 2pesd input
.
. . APECS
ldle verification =witch
— Controlier F‘ngrEml‘ﬂEHE BC
PTO enable switch > | parameters »| Calibration
Engine protection switch Tool
g
Auxiliary cutput 1 >
Auxiliary output 2 >
Power I == I

Figure 1-1. APECS Engine Control Basic System Setup
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Environmental and Electrical Specifications

Operating Temperature
—40 to +185 °F (—40 to +85 °C)

Storage Temperature
—40 to +185 °F (40 to +85 °C)

Shock
20 Gs at45 Hz

Vibration (Sinusoidal)
6 Gs from 40 Hz to 2000 Hz

Enclosure Protection
Deutsch PCB enclosure EEC-325X4B with two 12-way sealed connectors

Operating Voltage and Current
9-30 Vdc, reverse polarity protected

Maximum Current for VMAP Output (8800-1012 only)
60 mA continuous

Maximum Current for Auxiliary Outputs
200 mA continuous

Discrete Inputs Impedance
32 kOhm All Inputs Except EPSW
2.2 kOhm EPSW Input

Analog Inputs Impedance
220 kOhm (APP input)

Discrete Inputs Activation Voltage Thresholds
5.3 V maximum high level threshold (all inputs except EPSW)
0.9 V minimum low level threshold (EPSW Input)

Electromagnetic Compatibility (EMC) Protection
The unit has met the requirements of Automotive style testing:
ISO 13766:2006 ESA, EN/ISO 14982, EN 13309,
30-1000 MHz radiated emissions Limit
IEC 61000-4-2:2001, Operational ESD
+6 kV Contact, £8 kV Air
ISO 10605:2001(E), Handling ESD
+6 kV Contact to control pins, £8 kV Air to control pins
ISO 11452-2:2004 Radio Frequency Interference Immunity/Susceptibility
*100 Vrus/m Peak Envelope, 200 MHz to 1000 MHz 80% depth 1 kHz
AM. Demonstrates will meet EN 61000-6-2 10 V/m requirement.
ISO 11452-4:2005 Bulk Current Injection (BCI)
ISO 11452-4:2005 Bulk Current Injection (BCI) 20-200 MHz, 100
MARMS (peak envelop), No modulation and 80% AM at 1 kHz.
Demonstrates will meet EN 61000-6-2 10 VRMS requirement.
ISO 7637-2:2004 Pulse 1
—100 Vp to power inputs (more severe pulses clamped externally)
ISO 7637-2:2004 Pulse 2a
50 V to power inputs
ISO 7637-2:2004 Pulse 3a/3b
+250 V to power inputs
ISO 7637-2:2004 Pulse 5a
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100 Vp to power inputs
ISO 7637-2:2004 Pulse 5B
54 Vp to power inputs (clamped externally).

* SO 11452-2: Deviations on actuator current read back, used for gross position
error, were observed above 89.5 V/m (100 V/m -1 dB) in the 443-452 MHz range.
Since this is a secondary informational function not used in the control loop
beyond gross position check, this deviation was deemed acceptable.
The unit has met the requirements of Generic Industrial Emissions/Immunity (CE
mark) testing:
EN61000-6-4
CISPR 11 Group 1, Class A radiated emissions
EN 61000-6-2
IEC 61000-4-2 functional ESD
IEC 61000-4-4 functional EFT
Adjusted limits of £250 V based on cable lengths <3 m long and
application.

Ingress Protection rating
IP67 (according to EN 60529:1991+A1:2000) — only 8800-1012 controller, see
“Controller Installation” for mounting requirements

Weight
Approx. 0.6 Ib (0.27 kg).

System Components

The five main components of the system are the APECS controller, all-purpose
calibration tool (ACT), speed sensor, actuator, and linkage. In addition to the
main components, and depending on the features selected, there are several
subcomponents (such as speed switches and potentiometers). Each component
contributes to the overall performance of the system and shortcomings in any of
the components will detract from total system performance.

APECS Controller

The APECS 4500 series controller is an
electronic engine governor that provides a
means of controlling and limiting engine speed
by adjusting the fuel control lever with a
proportional actuator. The APECS controller
may be programmed to operate at up to four
different speeds. It also operates in either
isochronous or droop mode, where droop is
user selectable up to 15%.

The controller is software programmable and has no manual adjustments. A
calibration tool (ACT) is used for programming (configuring and adjusting) the
APECS 4500 controller.

All-Purpose Calibration Tool (ACT)

e ACT is a PC (personal computer) based
software calibration and monitoring tool. ACT is
= designed specifically for use with engines
equipped with the APECS 4500 controller. The
tool can be run on any IBM compatible
computer that meets the requirements listed in
“ACT Installation” in Chapter 3.

M. . wooDWARD

E

For APECS 500, APECS 3000,
APEDS ADD0. APECS 4600, APECS 5000, EPS 1000,
and 052 Software Copyright ©2006. Al Rights Resarved

Calibration Tool 7.3
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Once the APECS 4500 controller has been programmed, ACT may be
disconnected. The APECS 4500 unit will continue to operate normally with ACT
either connected or disconnected.

Speed Sensor

APECS 4500 monitors engine speed continuously. Engine speed may be sensed
by monitoring the frequency of spark events in spark-ignition engines or through
the use of a sensor that detects the passing of teeth on an engine driven gear

(e.g., flywheel).

The universal speed input of the APECS 4500 is compatible with the following

types of speed input signal:

e Magnetic Pickup. Magnetic pickups are available from Woodward

e Coil-type Spark Ignition. Speed can be sensed from the negative side of the
coil primary winding.

e Magneto Spark Ignition. Speed can be sensed from the spark kill wire on the
primary winding, but will not work if a diode is placed between the magneto
and the APECS input (may be found on some multi-cylinder engines with
magneto ignitions.

e Hall-Effect Sensor

Actuator

The actuator converts a pulse-width
modulated signal received from the
controller to an output shaft position
proportional to the duty cycle of the
pulse-width modulated signal.

The actuator is mounted on the
engine and connected to the control
lever by a mechanical linkage.

On spark ignition engines, the control lever is usually the throttle
IMPORTANT lever. On compression ignition engines (diesels), the control lever is

usually one of the mechanical governor levers (either shutoff or

governor).
Linkage
The linkage connects the actuator shaft to the engine @
control lever. A good linkage allows for misalignments _J@g;
and contributes to accurate, stable and responsive 5}/ f {

performance with minimal play or friction.

)00
@® =

The scope of this manual does not include selection and installation
IMPORTANT of speed sensors, actuators, or linkages that Woodward offers for
use with the APECS system. Information is available on our website
at www.woodward.com.
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The need for sub-components such as switches and potentiometers
IMPORTANT is application dependent. Please contact Woodward for information

specific to your application.

Programmable Features

The APECS 4500 expands Woodward'’s line of programmable engine governors
to address the needs of the mobile equipment industry. Enhanced input and
output capability, combined with a flexible configuration, permits the controller to
easily adapt to a wide variety of engine governing applications.

The controller is available in three versions which are described in Table 1-1.

Following is a list of features available with the APECS 4500. Features marked
with an asterisk (*) are not available on all versions of the controller. (See Table
1-1.)

e Analog Speed Setpoint Input: suitable for use with a potentiometer or an
accelerator pedal position sensor (idle verification available).

e Actuator Current Protection: protects actuator from burning out.

e Autocrank: useful for remote operation of engines using an auxiliary output.

e Auxiliary Outputs: two outputs which can be configured to drive lamps or
relays.

e CAN Communications: allows monitoring and/or controlling some APECS
parameters through CAN interface (*).

e Droop Governing: allows non-isochronous speed governing.

e Engine Protection Input: protects against adverse conditions such as loss of
engine oil pressure or excessive coolant temperature.

e Engine Start Calibration: useful for applications that require special startup
operation (e.g. warm-up speed, reduced governor gains, missing speed
signal).

e Glowplug Control: useful for enhancing cold start capability of a diesel engine
using an auxiliary output.

e Historic Fault Codes: retains a record of past fault codes, even after loss of
battery power.

e Overspeed / Underspeed Protection
o PID Gain Adjustment: allows governor response to be adjusted by user.

e PTO Switch Input: allows selection between analog speed setpoint input and
switched speed setpoint inputs in mobile applications.

e Switched Analog Speed Ranges: allows changing potentiometer speed
range based on digital inputs (*).

e Switched Speed Setpoint Inputs: allow multiple speed settings using
switches. This feature can be configured together with the analog input
(speed pot) for a variety of speed select options.

e Universal Speed Input: speed input is compatible with most common means
for sensing engine speed including mag pickup, ignition and Hall-Effect.

e Auto idle mode and configurable brake rate: provides additional brake mode
options (*).

Woodward 5
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To incorporate any of the programmable features in your system, refer to the
Features Table below to determine if additional hardware installation or software
configuration is required.

Features Table

All features available with the APECS 4500 can be easily installed and configured
to work with your application. Refer to the table below to determine if additional
hardware installation is required. Software setup is always required to properly
configure the feature.

Hardware required is customer supplied and is not sold or supplied by Woodward.
To incorporate any of these features in your system refer to “Installing the
Hardware section to install the selected feature and “Calibrating APECS Features”
chapter to configure the feature for your application.

Table 1-1 shows features available in specific APECS 4500 versions.

Table 1-1 APECS 4500 Features Table

5 TRBILLT FRETURE HARDWARERE | __FEATURE PRESENT I
QUIRED? SA-4489 | 8800-1006 | 8800-1012

Actuator Current Protection No . . .

Autocrank Yes . . °

Auxiliary Output Yes o . °

CAN Communications Yes . .

Droop Governing No ° . °

Engine Protection Input Yes . . .

Engine Start Calibration No . . .

Glowplug Control Yes . ° .

Switched Glowplug Time Yes .

Overspeed / Underspeed Protection No . . .

PID Gains Adjustment No . . .

PTO Switch Input Yes o . .

Analog Speed Setpoint Input? Yes o ° .

Switched Analog Speed Ranges Yes .

Switched Speed Setpoint Inputs? Yes . . .

Auto Idle / Configurable Brake Rate Yes .

IP67 Ingress Protection Yes °

(1) See Engine Speed Select Options table below
6 Woodward
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Engine Speed Select Options Table

The following speed select options are available with the APECS 4500.

SPEED SELECT OPTIONS

NO ANALOG INPUT

Use a speed switch to select up to 4
discrete speeds or use a momentary
switch to manually increase or
decrease speed at preset rates.

Speed
Switch

® " O

Mamentans
Switch

SPEED TRIM
Use a speed pot (analog input) to trim
the speed switch selected set speed.

Speed
Sunitch

& ™

Trim Fot

SET SPEED WITH POT
Use a speed pot (analog input) to
adjust set speed.

Spead Pot

%

SET SPEED WITH POT

OR SPEED SWITCH

Use a speed pot (analog input) to
adjust the set speed or use a speed
switch to select up to 4 discrete
speeds. Use the PTO switch to select
between speed pot and speed
switches.

Speed Speed
Pot Switch

P &

DRIVE-BY-WIRE

Use pedal pot (analog input) to adjust
set speed. Can be used with or without
IVS. Includes safety startup logic to
assure engine always starts at idle.

DRIVE-BY-WIRE OR SPEED SWITCH
Use a pedal pot (analog input) to
adjust the set speed or use a speed
switch to select up to 4 discrete
speeds. Can be used with or without
IVS. Use the PTO switch to select
between pedal pot and speed
switches. Drive-by-Wire mode assures
that the engine will never start up at a
high speed. Commanded speed will
remain at idle until the pedal returns to
idle. The PTO input must undergo an
off-to-on transition before starting PTO
mode.

Fedal SpeEd
Switch

CAN INPUT

Use a set speed value provided by
master on CAN interface to adjust the
set speed. Cannot be real time or
control loop time critical. (This option is
available only with devices which
support CAN interface).
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Chapter 2.

Installing the Hardware

Introduction

This chapter provides the general information for mounting location selection,
installation, and wiring of the APECS® 4500 control. Hardware dimensions,
ratings, and requirements are given for mounting and wiring the control.

When installing the APECS hardware, be aware that some of the options
selected may also require hardware setup (see list below). Hardware required for
optional features is not provided or sold by Woodward.

Take adequate protection to ensure personal and equipment safety and follow
the suggested installation sequence given below:

Install main components:

Wiring page 8
Speed Sensor page 15
Actuator & Linkage page 16

Install optional components (hardware installation required):

Engine Speed Setpoint—Analog Input page 17
Engine Speed Setpoint—Switched Inputs  page 18
Power Take-off Input page 21
Glowplug page 21
Autocrank page 22
Auxiliary Output page 22
Engine Protection Input page 23
Switched Analog Speeds page 24
CAN Communication page 24

Wiring Guidelines

APECS 4500 has two 12-pin Deutsch connectors labeled J1 (grey) and J2
(black). Mating connectors may be purchased from Woodward or from a Deutsch
distributor.

Woodward part numbers are SA-4490 (connectors only) and 8923-1853
(includes backshells for water ingress protection).

Deutsch part numbers are as follows:

J1 (Grey): DTM06-12SA

J2 (Black): DTM06-12SB

Sockets (pins, 12 per connector): 1062-20-0122

Wedgelocks (1 per connector): WM-12S

Blank Pins (to fill empty pins): 0413-204-2005

Backshell (required for water ingress protection, 1 per connector):1028-015-1205

Always use an appropriate crimping tool for attaching the pins to the wiring
harness. Pay close attention to the pin numbers embossed on each connector.

8 Woodward
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Wiring

In general, increased resistance can result from too much wire length,
inadequate wire gauge, or poor connections. Increased wiring resistance will
reduce signal quality of all signals. Excess inductance in wiring will cause similar
issues. Excessive resistance (& inductance) in the power and actuator wiring will
result in insufficient force from the actuator. To reduce inductance, power &
return and signal & return cables should be routed together in close proximity,
twisted as possible.

Good wiring practices should always be employed. A complete
understanding of the wiring harness and the devices attached to it
should be applied to the harness design. Wiring should be twisted

within each type and protected from wear. Specific wires require the
IMPORTANT use of shielding and shielding in general is a good practice.
Some good wiring practices include: routing signhals separated by

type, keeping power & signals separated, and twisting signal/return
pairs as well as power & return pairs.

Terminations must be impervious to moisture to prevent shorts and/or corrosion.

Use of convoluted tubing, conduit, or other wire shielding is recommended to
minimize the likelihood of mechanical damage to wires.

Avoid routing wires near sharp edges or near locations that can cause the wires
to be “pinched” or damaged.

Carefully follow all shield grounding practices described in this manual.

Table 2-1 shows the recommended gauges and maximum lengths of connecting
wires for different size APECS actuators. Wire insulation should be appropriate
for engine applications. Wire length is the total length (to and from) used to
connect the actuator to the controller and the controller to the system power.

Table 2-1. System High Current Wiring

AWG 14 AWG 16 AWG 18
Actuator* (2.50 mm?) (1.50 mm?) (1.00 mm?)
0175 66 ft (20 m) 33 ft (10 m) 22 ft (6.7 m)
0250 46 ft (14 m) 231t (7 m) 15 ft (4.6 m)
0300 46 ft (14 m) 231t (7 m) 15 ft (4.6 m)

(*) The controller has a working range of 9-30 Vdc. However, the actuator must

be selected for either 12 or 24 Vdc charging system.

Woodward
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Table 2-2. Controller Wiring Types

FUNCTION

PIN INFORMATION

REMARKS

Actuator Output

ACT+ (J1-5), ACT- (J1-8)

May be shielded, should
be twisted pair

ACT Connector

RCV (J1-12), TXD (J1-1), Vg2
(J1-11), GND2 (J1-2)

Shielded, twisted triple

Analog Input

APP (J2-12), Vger (J2-11), RTN (J2-2)

May be shielded

Auxiliary Output

AUX (J2-4), Vgar (J1-9)

May be shielded

Auxiliary Output #2

AUX 2 (J2-3), Vgar (J1-9)

May be shielded

Battery

VBAT (J1-9), GND (J1-4)

May be shielded, should
be twisted pair

CAN Interface

CANL (J1-6), CANH (J1-7)

Unshielded, twisted pair

Engine Protection Input

EPSW (J2-9), GND (J1-4)

Typically unshielded,
may be shielded

Idle Verification

IVS (J2-5), Vaar (J1-9)

Typically unshielded,
may be shielded

Power Take-off

PTO (J2-6), Viar (J1-9)

Typically unshielded,
may be shielded

Speed Signal Input

RPM+(J1-10), RPM-(J1-3)

Shielded, twisted pair

Switched Inputs

SW1 (J2-7), SW2 (J2-8), Vgar (J1-9)

Typically unshielded,
may be shielded

Power leads are to be connected directly to a switched power source (i.e.,
battery). Use of a 10 amp, slow-blow fuse is recommended in the battery
(positive) wire. Power leads may also need some form of transient pulse
suppression external to the control but near its input pins. An example is given in
Application Note 51319, however AN 51319 is for a different family of products
that are somewhat more susceptible.

Use shielded cable for external speed signal source. Speed signal shields should
be connected to chassis ground at one end only. The shield should be directly
terminated to ground at the sensor end and the shield should not be connected

at the control.

Use shielded cable from the Serial communication port to the connected
computer or other device, only terminate the shield at the end away from the
control. ACT adapter SB-3124 should be close to the control and the shield
should extend from it to the computer or other device.

Shielded cables should keep the exposed cable wires as short as possible, no
longer than 2-3”. Shields are expected to be >95% coverage: foil, braid, or folil
plus braid are acceptable shields. Braid shields tend to be more robust.

Other cables may be shielded as desired, however the shield must not be
terminated to the common on the APECS 4500.

10
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APECS 4500 Electronic Engine Speed Governing System

Controller Installation

Controller Dimensions

4,000°

3.701"

4.608" 2953

hosET

Ws.

£26 [V Homavd §1 % ozl
s o

AN
SER
[

APCLE 45040 PINDLUT

ol

4.000"

1427

Figure 2-1. APECS 4500 Dimensions

Woodward
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Installation Requirements

When selecting a location for mounting the APECS 4500 control, consider the
following:

The operating range of the APECS 4500 control is —40 to +185 °F (—40
to +85 °C) place the control where it will not see temperatures outside its
operating range.

Manual 36752D

Vibration: 6 Gs from 40 to 2000 Hz
Protect the unit from direct exposure to impact or abrasion.
¢ Do not install the unit or its connecting wires near high-voltage or high-
current devices. If this is not possible, shield both the control with its
connecting wires and the interfering devices or wires. (Spark plug wires
should be > 15 cm (6 inches) from the control.)
o Damaged or worn plug wires cause substantial arcing energy
that may interfere with the proper operation of the control.
Susceptibility to this interference has been minimized; however it
depends on plug wire proximity to the control.
e Allow adequate space around the unit for servicing and wiring.
e When installing on a generator set package, provide vibration isolation.

Table 2-3. Controller Wiring

FUNCTION

PIN INFORMATION

REMARKS

Actuator Output

ACT+ (J1-5), ACT- (J1-8)

High side driver,
100Hz PWM

ACT Connector

RCV (J1-12), TXD (J1-1), Vgg, (J1-11),
GND2 (J1-2)

Analog Input

APP (J2-12), Vger (J2-11), RTN (J2-2)

Auxiliary Output

AUX (J2-4), Vgar (J1-9)

Low side driver

Auxiliary Output #2

AUX 2 (32-3), Vgar (J1-9)

Low side driver

Battery

VBAT (J1-9), GND (J1-4)

CAN Interface

CANL (J1-6), CANH (J1-7)

External termination
required

Engine Protection Input

EPSW (J2-9), GND (J1-4)

Switch to Ground

Idle Verification

IVS (J2-5), Vgar (J1-9)

Switch to Vgat

Power Take-off

PTO (J2-6), Viar (J1-9)

Switch to Veat

Speed Signal Input

RPM+(J1-10), RPM-(J1-3)

Switched Inputs

SW1 (J2-7), SW2 (J2-8), Vaar (J1-9)

Switch to Veat

12
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Required Mounting Position for IPx7

To obtain IPx7 water ingress protection, it is required to install module in the
specific position with harness first fixation point as presented Figure 2-2.

woo%un D
APECS

Orientate unit | _
vertically, with ) S oEj _ Place harness first

connectors fixation paint at the

downwards A | , ‘,—fl‘ height of controller's
(JH L ) l Y enclosure
e

iy

%M‘.

7/
Ve

—_ 7

Horizontal plane

Figure 2-2. Controller Mounting Position
Please also note that:
e |P67 rating is available only for 8800-1012 controller.

e Additional connector backshells are required for IPx7 (see wiring
guidelines).

Woodward 13
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Controller Pinout

Use the diagram below to connect your APECS controller to ACT, your preferred
speed sensor, and various inputs and outputs.

Calibration Tool Setup

Speed Sensor Input

- |
RS-232 Cable Twisted Pair Shielded Wire Eﬁ-— |
1 (shield grounded at controller only)  RPM+ (J1 10) | El

Hall Effect

Computer

Magneto

I
[l - Lhem |
GND2 (J1 ? JIH i O%Cﬁ

VBB2 (J1 11) Twisted Pair Wire
TXD (J1 1) (> 1 twist per inch) ACT+ (J15)

Proportional Actuator Output

RCV (J1 12)

-
Analog Speed Input

APP (J212) | T
e _L| External controller
GND (J14) 1| _ 0.5-4.5VDC
I

OR
VREF (J2 11)!

Potentiometer
) J ) app(212)!
\SRTN (J2 2)! or w

4-pin mating connector/’f

(Molex 39-01-2040)

| Pot Pedal
+ _______
IVS (J2 5) Idle Verification
(used with pedal input)
APECS 4500 Controller
Switched Speed Input
\_ SW1(J27)
\ SW2 (J28) Switched
Slow Blow Fuse to VBAT
Power (DC) VBAT (J1 9 (10 amp)
Ecd GND (J1 4) Augxiliary Output
T | \ AUX (J2 4) Q @
Twisted Pair Wire 12-24v output o
(> 1 twist per inch) Lamp Relay
VCU CANL (J16) Auxiliary Output 2
. . R* AUX2 (J2 3)
Vehicle Control Unit CANH (U1 7) $ AN | or
(CAN Master) 12-24v output
Lamp Relay
PTO Switch Input
. PTO (J26
*Each end of the main backbone of the CAN . (25) . Switched
bus must be terminated with an apropriate =E"!I|! == to VBAT
resistance connected between CANH and
CANL conductors. The termination resistance Engine Protection Inout
should be nominal R=120Q with a minimum EPsW U29) gine Frofecton Inpu
power rating 400mWw. o Switched to
Ground

Figure 2-3. APECS 4500 Wiring Diagram
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Speed Sensor Installation

Guidelines

There are four different speed-sensing devices that can be used with the APECS

4500 system.

Magnetic pickup
e Spark ignition

e Magneto

e Hall Effect sensor

Refer to Table 2-1 and Figure 2-3 for guidance in selecting the speed sensor

suitable for your controller and application.

For magnetic pickups and Hall Effect Sensors, the mounting of the sensor unit
must be rigid; excessive vibration can cause erroneous signals and unreliable

performance.

Use twisted pair shielded wire for all speed sensor wiring. Shield should be

grounded at the sensor only.

APZCS 4500
RPM+-(J1-10)

S 2
\/

RPM- (J1-3)/

Figure 2-4. Speed Sensor Wiring

Speed Sensor Wiring

Magnetic Pickup

Installed opposite an engine driven gear such as the flywheel,
it transmits a signal each time the magnetic flux path across
the pole is interrupted by a gear tooth.

Connect Pin J1-10 to the positive and Pin J1-3 to the
negative side of the sensor. Most sensors do not have a
positive or negative side and can be connected either way.

Spark Ignition

M distributorless ignition systems.

A

Intended for either traditional coil and distributor ignition or

(c ’_?“"JKFET’ Traditional coil and distributor ignition; 2-, 3-, 4-, 6- and 8-
J T “j? cylinder engines: Connect Pin J1-10 to the negative side of
the coil primary.
[l
" ‘ Distributorless ignition, 2-, 4-, 6- and 8-cylinder engines:
S Connect Pin J1-10 to the negative side of one coil primary.

May not work with ignition systems that vary the coil charging voltage

(e.g. Ford TFI).

Woodward
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Magneto Ignition
Typically found on small 1- and 2-cylinder engines

Connect Pin J1-10 to the primary/engine kill wire and
Pin J1-3 to the engine block.

Hall Effect

Located next to an engine driven gear

Connect Pin J1-10 to the sensor output and Pin J1-3 to the
negative side of the sensor. The third sensor lead should be
connected to battery positive.

It is beyond the scope of this manual to discuss detailed
IMPORTANT speed sensor selection and installation for all possible
applications. Please contact the factory for specific
information concerning your application.

Actuator and Linkage Installation

The APECS 4500 controls an actuator with a high side PWM output working on
100 Hz frequency.

Select actuator with sufficient force to move the fuel control lever from minimum
to maximum fuel position. The controller has a working range of 9-30 Vdc.
However, the actuator must be selected for either 12 or 24 VVdc charging system.

Select or design a bracket that correctly aligns the actuator shaft and control
lever and is able to withstand the vibration level of the engine or application.

The linkage must have minimal friction, binding and backlash. The bracket and
linkage should be designed to use as much of the actuator travel as possible.

Fasten actuator to bracket and bracket to engine. Attach necessary linkage
between actuator shaft and fuel control lever. Move linkage end-to-end to confirm
correct travel and adjust length if needed.

Connect actuator wires (use twisted pair with more than 1 twist per inch).
Actuator travel should be adjusted to assure both maximum (start fuel or rated
load) and minimum (shutdown or idle) positions.

APECS 4500
ACT+(J1-5)

/ )
ACT-1-8)/ % =

Figure 2-5. Actuator Wiring

It is beyond the scope of this manual to discuss detailed
IMPORTANT actuator selection and installation procedures for all

information concerning your application.

possible applications. Please contact the factory for specific
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The unit has degraded performance on the internal
IMPORTANT actuator current feed back when subject to 100 V/m in the
443-452 MHz range. Performance is just outside normal
and returns to normal by dropping the level 1 dB or to ~90
V/m. 32 V/Im is the typical automotive sub-component
requirement called in the standards above. The read back

deviations at 100 V/m do not affect performance of the
control.

Engine Speed Setpoint Wiring—Analog Input
Guidelines

The APECS 4500 controller features an analog speed input for mobile or
stationary applications. To incorporate this feature, wire the analog input to an
external pot (which is normally connected to a pedal) or an analog input from an
external controller. Use Figure 2-6a as a guide to wire external speed controller
or Figure 2-6b to wire potentiometer to your application. Potentiometer
resistances of 3-5 kQ are recommended. Analog input impedance is 221 kQ.

Once the analog speed input is wired, refer to the APECS Calibration section to
configure the appropriate parameters.

If use of an idle verification switch (IVS) is desired, hook up Pin J2-5 from the
controller to the idle verification switch on the pedal. (Refer to the manufacturer’s
instructions or OEM manual.) The other side of the switch should be connected
to battery voltage (see Figure 2-7).

During engine operation, if the IVS switch and pedal pot do not agree, the engine
will operate at 10% of actual position of the pedal.

An analog speed bias signal input may also be used for load sharing in stationary
applications. The analog voltage (0-5 volt max.) should be wired across terminals
J2-12 (positive) and J1-4 (ground).

APECS 4500
APP (J2-12)
., — Y

0.5-+4.5VDC
Analog input
GND(J1-4)
p—e

Figure 2-6a. Analog Speed Bias Input

Woodward 17
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APECS 4500

VREF (J2-11)

APP (J2-12)

SRTN (J2-2)

Figure 2-6b. Analog Input Switch

VREF (J2-11)

APP (J2-12)

APECS

4500
SRTN (J2-2) Vbatt +

IVS (J2-5) s

DVS Switch

Figure 2-7. Analog Input Switch with IVS

VREF and SRTN pins’ internal circuits are designed only for

IMPORTANT connecting the potentiometer as shown on Figure 2-6b. Do
not use either of those pins as a power supply or a ground
connection for any other external component.

Engine Speed Setpoint Wiring—Switched Inputs

Guidelines

The APECS 4500 controller has two switched speed inputs for multiple speed
settings. This is convenient for customers who need more than one speed for
engine governing (i.e., idle speed/power speed setting or low power/high power
setting).

To incorporate these switched inputs, determine the speed mode desired based
on your application. The five modes available are Single Speed, Two Speed,
Three Speed, Four Speed, or Variable Speed.

After determining the speed mode, select the switch hardware best suited for
your application. (Switch hardware is not provided or sold by Woodward.)
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Choose a switch designed for low currents (5 to 20 mA). Avoid choosing higher
current devices that rely on the current to clean the switch contacts. A dry circuit
switch is recommended.

The speed select switch is typically mounted on the control panel but can be
mounted in any other suitable location.

Use the accompanying diagrams as a guide for wiring the selected switch to your
controller.

Once the speed select switch is wired, you need to calibrate “Engine Set Speed
Calibration” parameters to make the feature work. Please refer to APECS
calibration chapter to configure the appropriate parameters according to the
selected speed mode.

Switch Wiring
Vboatt +
APECS 4500 M
Speed Select 1 927\ Connections
Speed Select 2 ﬂhc Caonnecticns
(J1-4)
€L

Single Speed Mode
No switch is needed.

%
Vbatt +
I 1 To Vbatt 4
APECS 4500 (J1-9) G |
(J2-7) 7,
Speed Select 1 ————0 '<~‘—1‘4——~J
Speed Select 2 [ 2 8) No Connecticns
(J1-4)
L

Two Speed Mode

A toggle switch is used to select between
two set speeds.
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=

Vbatt +
1 To Vhatt +
APECS 4500 J1-9) O |
J2-7 2
Speed Select 1 ;O /F*—I
J2-8
Speed Select 2 %DIZ
(J1-4) 3

Three Speed Mode

A three-position rotary switch is used to
select among three set speeds.

Vbatt +
To Vbatt +

APECS 4500 el O

(J2-7) 2 }
Speed Select 1 e V\"O——J
Speed Select 2 L 4 O

3
4
(J1-4)

Four Speed Mode

A four-position rotary switch with two diodes is
used to select among four set speeds.

Typical diodes that can be used with the four
speed mode are 1N4001 and
1N4002 up to 1N4007

Vbatt +

l‘
i To Vbatt +
i O WTT
APECS 4500 W1-9) .

Down
)

2-7)
Speed Select 1

|
& ’____J
Speed Select 2 | (J2-8) g

D)
(J1-4) Jp

Variable Speed Mode

A momentary switch is used to ramp
desired engine speed either up or down.
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Power Take-off Input Wiring
Guidelines
The APECS 4500 controller offers a Power Take-off (PTO) feature that allows
the controller to switch from pedal input to switched inputs for mobile
applications. Alternately, the PTO input may be configured for the autocrank
feature.

To use the PTO input, wire a switch to Pin J2-6 on the controller. Once the input
is wired, refer to Chapter 5 to configure the appropriate parameters.

The PTO input is switched to Vbat.

APECS 4500 Vbatt +

PTO (J2-6)

Figure 2-8. PTO Input Wiring

Glowplug Wiring

The APECS 4500 offers a glowplug feature for remote or automatic starting of
certain engines and applications. Either of the two auxiliary outputs may be
configured for glowplug operation.

Wire the glowplug relay on the engine to either of the controller auxiliary outputs
(low side drivers). Wire the auto-start (rocker/toggle) switch to the controller PTO
input (switch to Vbat).

The diagram below shows how to wire the glowplug feature. Once the input is
wired, refer to Chapter 5 to configure the appropriate parameters.

Vbat

APECS 4500
PTO (J2-6)

Auto Start Switch

Vbat

]
o [

Aux 2 (J2-3)

Glow Plug
Relay

Low Side Driver

Figure 2-9. Glowplug Relay Wiring
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IMPORTANT

When the glowplug feature is used, the PTO switch input cannot be
used for other features.

If using the glowplug feature, make sure you calibrate the controller
for the glowplug feature prior to hook up. If the controller is not

" calibrated for glowplug and the glowplug relay is hooked up, the

glowplug relay may turn on as soon as power is applied to the
controller. (Refer to Chapter 4 for the glowplug calibration.)

Autocrank Wiring

The APECS 4500 offers an autocrank feature for remote or automatic starting of
certain engines and applications. Either of the two auxiliary outputs may be
configured for autocrank operation.

Wire the crank motor relay on the engine to either of the controller auxiliary
outputs (low side driver). Wire the auto-start (rocker/toggle) switch to the
controller PTO input (switch to Vbat).

The diagram at left shows how to wire the autocrank feature. Once the input is
wired, refer to Chapter 5 to configure the appropriate parameters.

Vbat

PTO (J2-6) .~

Auto Start Switch

APECS 4500

Vbat
P

AUX (J2-4) 3 ]
or -

X223 CRANK MOTOR

Low Side Driver RELAY

Figure 2-10. Autocrank Wiring

IMPORTANT

When the autocrank feature is used, the PTO switch input cannot be
used for other features.

If using the autocrank feature, make sure you calibrate the controller
for the autocrank feature prior to hook up. If the controller is not

" calibrated for autocrank and the crank motor relay is hooked up, the

engine may start as soon as power is applied to the controller. (Refer
to Chapter 4 for the autocrank calibration.)

Auxiliary Output Wiring

A lamp or relay can be wired to either of the two auxiliary outputs on the
controller for a variety of purposes: (1) to flash faults, (2) to indicate overspeed
condition, (3) to indicate diagnostic shut down, (4) to indicate PTO engaged, (5)

22
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for autocrank output, (6) for glowplug relay control, and (7) indicate auto-idle
being enabled.

Depending on your application, wire the lamp or relay according to the
manufacturer’s specification. Once the output is wired, refer to Chapter 5 to
configure the appropriate parameters.

If the output draws more than 200 mA, the output will be disabled
“ IMPORTANT and a fault code will flash.

To prevent damage of the lamp driver, avoid direct shorts to Battery
Voltage during installation and regular operation of the control.

“ NOTICE

Vbalt
APCES 4500 Vbatt+ *
A APECS 4500 I
O
Lomp Q@ L #
AUX (J2-4) AUX (J2-4) T
or or U O
AUX 2 (J2-3) AUX 2 (J2-3) T RELAY
Low Side Driver Low Side Driver
Figure 2-11. Typical Lamp Wiring Figure 2-12. Typical Relay Wiring

Engine Protection Input Wiring

Optional Feature

The APECS 4500 controller offers an engine protection shutdown feature to
safeguard against adverse operating conditions such as low oil pressure or high
coolant temperature.

The engine protection (EP) input is a switched input similar to the set speed
inputs. This input must switch to ground potential (negative battery terminal).

Figure 13 shows how to wire the EP input. To use more than one sensor, simply
wire the sensors in parallel as shown in Figure 14. Once the input is wired, refer
to the APECS Calibration chapter to configure the appropriate parameters.

APECsA00 APECS 4500 Oil Pressure {#)-
Qil Pressure -@.-
' EPSW (J2-9) L
EPSW (J2-0) | st il =
M
Coolant Temp. @ﬂ
=
B =
Figure 2-13. EP Input/Single Sensor Figure 2-14. EP Input/Multiple Sensors
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Switched Analog Speed Wiring

Three digital inputs: EPSW, SW2, PTO may optionally serve as speed range
switches that alter analog speed range and governor gains. (See “Switched
Analog Speed Ranges and Governor Gains” in Chapter 5 for configuration
details.)

Wiring for these switches is the same as when they are used for other purposes.

Note that speed range switch 1 optionally serves additional function of controlling
the glowplug heating time. (See “Engine Start Calibration Parameters” in
Chapter 5 for configuration details.) Additionally, polarity of this input when
working as a speed range switch is software configurable with SW_OPTIONS2
parameter.

APECS 4500 -

PTO (J2-6)

Speed range
switch 3 S

SW2 (J2-8) h g

Speed range

switch 2
EPSW (J2-9)
Speed range l?
switch 1 GND

Figure 2-15. Speed Range Switches Wiring

CAN Communication Wiring

Optional Feature

The APECS 4500 controller offers an optional J1939 CAN communication
feature to allow remote updates of speed settings and reading the control status.

See Chapter 4: “Can Communication” for information about wiring, shielding and
terminating of the CAN interface.

The CAN J1939 communication port is not intended for critical
IMPORTANT communications and is only provided as limited use port, such as

reading values form the APECS 4500 as a service port. CAN must
only be used for messages that monitor control status or set non-
critical control values. CAN communication may not be a
determinative portion of the control loop.
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Chapter 3.

ACT Oeeration

ACT Installation

Description

The All Purpose Calibration Tool (ACT) is used for programming (configuring and
adjusting) and monitoring the APECS controller with your personal computer.

The ACT software resides on a PC and communicates to the APECS 4500
controller through J1 connector. The ACT Kit (Woodward part number SA-4488)
is required to make communications possible. The ACT Kit contains the
following:

e Interface module

e Calibration tool interface

e RS-232 connecting cable

Set-up Requirements

Hardware Requirements

e PC-compatible laptop or desktop computer with at least one available
serial communications port, and Windows 95/98/ME/2000/XP/Vista as
the operating system [Note that ACT has not been completely tested and
verified under Vista and Windows 7.]

e 64 MB of available RAM memory and hard disk with at least 4 MB of free
disk space

e SVGA capable video card and monitor, capable of 256 colors and 800 x
600 display

Software Requirements
e APECS Calibration Tool (Woodward P/N 5418-2570)
e ACT software can be downloaded and installed from the Woodward
website (www.woodward.com/software).

Hardware Set-up
To connect your PC to the APECS 4500 unit, an RS-232 connecting cable with
proprietary interface module and calibration tool interface is required.

Make sure power to the PC and the APECS unit is off when making
IMPORTANT connections. The engine may or may not be running.

Connect one end of the RS-232 cable to your PC’'s COM port. Connect the other
end of the cable to the interface module.

Now connect the interface module to the APECS 4500 unit via the connector on
the harness. The interface harness is inserted between the J1 (grey) connector
of the controller and the mating connector in the user’s wiring harness.

If your PC is not equipped with a COM port you may need to use USB to RS-232
converter. Woodward recommends the following converters:

e USB 1.1 to RS-232 Converter (Woodward P/N 1249-1175)

e USB 2.0 to RS-232 Converter (Woodward P/N 1249-1176)
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Figure 3-1. ACT System Set-Up

disconnected during normal operation.

The serial communication port is intended as a service port only. It
IMPORTANT may only be connected as a configuration and tuning tool, then

Software Set-Up

The first step in installing the software is to download the installation file from the
Woodward website. Make sure you use the most recent software version.

Make sure power to the PC and the APECS unit is off when making
IMPORTANT connections. The engine may or may not be running.

The installation program steps you through the installation process. You may

select the default directory or specify your own.

After installation, to execute the program select Start ->All Programs -

>Woodward >ACT Tool and click on the ACT Calibration Tool icon. Please refer

to “Running the ACT Software” below.

26
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Basic ACT Operation

Running the ACT Software

The ACT software is fairly easy to use. Follow the procedures below to run the
program.

|%

1. Make certain that the APECS Sesttasn
controller is powered up and
connected to the computer’s
COM port. N

regardless of the form of media, without prior
wirtten cons=nt of Woodward. Inc.

Toppight [C) 2004 Weodnad, Inc

“oodaard, Inc, makes no waranlies, supress

2. Ifan icon for the calibration tool e e b
exists, double click on it to start SR

. Any damages, lss of popeity, of olfes costs iesulling

the ACT software. The license o e

screen will be displayed when the
ACT is launched. You must either
accept the terms or Cancel, which e
exits the application.

(.1 ecoept the terms of this agreement 4|

3. Ifnoicon exists, click on the Start button, highlight “Programs,” find the ACT
software and click to start it. Default is Woodward, then select “ACT Tool”
and “ACT Calibration Tool.”

4. Make sure the COM port designation in ACT matches the serial port on the
back of your PC.

5. Follow the procedure outlined in the Configure Menu to change the COM port
assignment, if needed.

Progress Display Screen

This screen is intended to inform the user of the progress of time-consuming

communication procedures. It will close automatically when the procedure is
complete.

Fieading Calibration Y alues from controller. Pleaze wait.

RESET_SPEED_2

Moving Around the Software

There are five main menu items available with ACT. Several options are

available under each main menu item. The discussion in the following pages

assumes the cursor is at the main menu screen.

¢ Use mouse to select or move around the menu.

e Use left mouse to execute a command or accept a condition.

e Use function key <F1> for HELP.

e A HOT key (highlighted character in a menu item) can also be used to
access or activate a menu or sub-menu, e.g. File use <ALT> <F>.

e Click on the lﬂ box in the upper right hand corner to exit ACT.
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ACT Menus and Options

ACT Menu Structure

The ACT has five main menus: File Menu, Calibrate Menu, Monitor Menu,
Configure Menu, and Help Menu with several options available under each. A
complete discussion of all ACT menus and options is presented in the following

pages.

FILE MENU

Save APECS Cal to File

View CAL File Comments

View Text File

Convert APECS Cal to Text

Convert Cal File to Text

Convert Cal File to Strategy

CALIBRATE MENU

Change APECS Calibration

Download Cal FILE to APECS

Compare APECS Cal to File Cal

Change APECS Password

APECS Calibration Wizard

MONITOR MENU

Parameter View

Parameter Plot

Display Faults

Control Strategy

Parameter List

CONFIGURE MENU

Configure Serial Port

HELP MENU

Help Topics

About ACT

User Manuals

28
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File Menu

Purpose

The File Menu allows you to perform operations related to viewing, saving and
converting files. The following commands are available under the File Menu.
e Save APECS Cal to File
View Cal File Comments
View Text File
Convert APECS Cal to Text
Convert Cal File to Text
Convert Cal File to Strategy

Save APECS Cal to File

This command allows you to save APECS calibration data to a designated file.
The ACT uploads the calibration set from the APECS controller and saves it to a
computer file. This operation is usually done after the controller has been
calibrated for satisfactory engine performance but can also be done at any other
time. The data is saved in a binary file format that is not readable.

To Save APECS Cal to File:
1. Choose File > Save APECS Cal to File.

ACT will prompt the path where the file will be saved:

2lxl
2. Enter a file name to save the calibration = S|S0 o=
data to.
ACT will automatically append the file
extension .ACT to the file name if you
do not specify one. Click Save or press
< Ente r>. File name: IMy Ll Filg] Save I
Save a5 bype: IEAL Files ["ACT] d Cancel |/
Z
ACT will then read all of the
Current Ca|lbl’atlon Va|UES Processing Calibration 'alues
from the controller. This
screen shows the progress. SET_SPEED 4
]
A ] Once all the values are read, ACT will

Y prompt you to add comments to the
\;.f/ Do you wish ko edit the new Cal File Comments? | ACT file to aid in later identification.
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3. If you click Yes, the comment 5
editor screen will appear. S g e

Catmest List

To enter comments, type them one
at a time and press <Enter> or
click Save Edit. You can re-edit
comments by clicking them,
changing the text on the top line
and clicking Save Edit. Comments
can be deleted by clicking on them

and then clicking “Delete” or by e : L_{'_“ -
pressing <Del>. Sl |

4. Click OK on the comment editor or press <Enter> twice to save comments.
Click Cancel or press <Esc> twice to close the window without saving
comments. The Cal File will still be created if the comment editor is canceled.

5. The following message is displayed when the file is created successfully.

@ Coodward | ACT ToolhCal kool stuff 1,ACT Created Successfully

The file name in this message is the file selected in Step 2. ACT will save the
calibration data to the designated file and display “Calibration Data Saved in File:
ABCD.ACT” message (where ABCD is the name you entered in Step 2).

The “Save APECS Cal to File” command stores the calibration data as
IMPORTANT an .ACT file that cannot be viewed or printed directly. Viewing and

printing must be done from a converted text file. See Convert APECS
Cal to Text and Convert Cal File to Text commands.

View Cal File Comments

This command allows you to display the comments that are attached to a
calibration file. Users add comments when saving a calibration file. The
comments help in tracking specific engine, application, and environment data for

WhICh the Ca||bl’at|0n flle was Created Select a Calibration file and its comments are di 2=l
Look jn: ImDESkmD j ~ & ef EB-
- H H @ aCUments
To View Calibration Comments: S conprer
A . ) EE My Network Places
1. Choose File > View Cal File CADSvsreanes
DEMO, 000
Comments. EF Pafs
ACT will display a list of files on the
left side of the screen with file g |
comments on the nght Files of type: | Cal Files(*.000:2ACT) =l Close

™ Open as read-only

2. Use the Up and Down arrow keys to
highlight the desired calibration file
(.\ACT extension) and view the
comments attached to that file.

3. Click OK or Cancel to close
Comment Viewer. The comments
are created or edited when the files
are created.

Calibration File Commets:
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View Text File
This command is a convenient way to view text files.

Choose File > View Text File.

ACT will prompt for a text file to view.

Select a file and click OK.

ACT will open the selected file with the default viewer for that file type.

PN PE

Convert Commands

The “Save APECS Cal to File” command, discussed earlier, stores the calibration
data as an .ACT file that cannot be viewed or printed directly. Viewing and
printing must be done from a converted text file.

There are two convert commands available with ACT: “Convert APECS Cal to
Text” and “Convert Cal File to Text.” The difference between the two commands
is as follows:

1. In*“Convert APECS Cal to Text” operation, the calibration set that is
converted is from the APECS unit.

2. In“Convert Cal File to Text” operation, the calibration set that is converted is
from a previously saved file.

You may use the View Text File command to view text files.

Convert APECS Cal to Text

This command allows you to create a text file of APECS calibration data for
viewing or printing from any text editor utility in Windows. A printed copy of the
calibration data can be useful for future reference.

To Convert APECS Calibration to Text:
1. Choose File > Convert APECS Cal to Text.

2. ACT will prompt you to enter a name to save the text file. Enter a file and
click OK.

ACT will read all of the calibration values from the controller, create and save a
text file with the parameter names, values, and units, then display the file using
the default text viewer.

Convert Cal File to Text

This command allows you to convert a previously saved .ACT calibration file to a
text file for viewing or printing from any text editor utility in Windows. A printed
copy of the calibration data can be useful for future reference.
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To Convert Cal File to Text:

1. Choose File > Convert Cal File to Text.

2. ACT will prompt you to enter a name to save the text file. Enter a file and
click OK.

ACT will read all of the calibration values from the controller, create and save a
text file with the parameter names, values, and units, then display the file using
the default text viewer.

Convert Cal File to Strategy

This command is used to convert old ACT files for use with controllers that have
a different control strategy version.

ACT will:

1. Parse through all of the calibration parameters in the old ACT file.

2. Search for the same calibration parameters in the new ACT file and assign
values from the old calibration.

To Convert a Cal File to a New Strategy:

1. Choose File > Convert Cal File to Strategy.

2. ACT will prompt you to enter a name to save the text file. Enter a file and
click OK.

ACT will read all of the calibration values from the controller create and save a
text file with the parameter names, values, and units, then display the file using
the default text viewer.

Calibrate Menu

The Calibrate Menu allows you to perform operations related to APECS
calibration. The following commands are available:

Change APECS Calibration*

Download Cal File to APECS*

Compare APECS Cal to File Cal

Change APECS Password*

APECS Calibration Wizard*

(*) These commands can be password protected to prevent unauthorized
calibration changes. See “Change APECS Password” for more information.

Change APECS Calibration

The “Change APECS Calibration” command allows you to calibrate (configure
and adjust) various parameters associated with the APECS controller.

APECS 4500 is a programmable engine governor. Changing APECS calibration
parameters is the means to configure the APECS controller for specific engines,
applications and environments, and for adjusting PID gains.

The calibration parameters have been organized into categories for your
convenience. Browse through the categories to view the specific parameter you
want to change or adjust.
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Some parameters must be set before the engine can run. Other parameters can
be adjusted while the engine is running. A complete list of parameters appears in
“Understanding APECS Calibration Parameters” in Chapter 5.

All adjustments are stored immediately in non-volatile memory in the APECS
unit. The APECS controller will retain the changes even if power is lost or the
ACT is disconnected.

To Change APECS Calibration Parameters:
1. Choose Calibrate > Change APECS Calibration.
2. Setthe “View Filter” to select a group of parameters.
3. Use F5/F6 to scroll through the list.
4. To change the highlighted parameter:
Enter the new value in the “New Value” field
Press <Enter>
The new value is written to the controller and then read back, with the result
placed in the “APECS Value” field.
5. Press <Esc> to exit.

Download Cal File to APECS

The “Download Cal File to APECS” command allows you to download the entire
calibration set from a file to the APECS permanent memory. This is a convenient
one-step method for:
¢ Reverting back to a known good calibration set after experimenting with
new calibration settings
e Programming multiple APECS units for a particular application

The downloaded file may have been previously configured and calibrated for
satisfactory engine performance with another APECS unit.

1. To Download a Cal File to APECS: [Choose a Calibration Fle E TR 2l
Look ir: | (] Desktop =] & & ek -

[Z3my Documerts

Choose Calibrate - Download Cal )
File to APECS. The following screen 0 System s
allows you to select a Cal file to

download.
File name: | Open |
Files of upe: IEaI File(=.000;* ACT) = Cancel

I~ Open as sad-only

Calibration File Comments:

2. Choose a file and click OK. The following screen will show the progress.

Proceszing Calibration ' alues

OVERSPEED_RPM
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3. The following screen is shown when the operation is complete.

ACT x|

L] "_'., The calibration File was downloaded successfully,
L

During the “Download Cal File to APECS” operation, the user may
IMPORTANT encounter a situation where the Cal File password is different from
that of the APECS unit. If this happens, please refer to the steps

below to complete the download operation.

To Download a Cal File to APECS with a Password Different from that of
the APECS Unit:

Anytime the APECS password is added or changed, the new password is stored
in the unit as well as in any calibration file saved after the change.

During a “Download Cal File to APECS” operation, if the password stored in the
calibration file matches the password in the unit, ACT will readily download the
calibration to the APECS unit.

However, if the password stored in the calibration file does not match the
password in the APECS unit, ACT will alert you of a password mismatch. Please
follow the steps below to complete the download operation.

1. When a password mismatch is detected, the ACT displays a message “Cal
File password differs from that of the APECS unit. Download the Cal File
password to the APECS unit?”

2. If you answer Yes to this message (see note below), the calibration file will
be downloaded and the password in the APECS unit will be changed to
match the password stored in the calibration file.

3. If you answer No to this message, the calibration file will still be downloaded
but the password in the unit will remain unchanged.

Before answering Yes to the message, make sure you know the

IMPORTANT password in the calibration file. If you do not know the password,
you will not be able to access the password protected features under
the Calibrate menu.

Please see “Change APECS Password” command for more information on
password protection.

Compare APECS Cal to File Cal

This command lets you check the differences in calibration sets between a saved
file and the APECS unit. The feature is useful, for example, to ensure that the
saved file matches the calibration in the APECS unit.
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To Compare APECS Cal to File Cal:

1.

rhonse a Calibeation fle to compare 214
Loak e | ] Deskiop =]« &t B

Choose File > Compare APECS Cal to File
Cal. This screen allows you to select a Cal
File to compare.

Flepam ||

Fiez of type [ Cal Fibes[ 000:+ ACT)
™ Open s yeasd-orly

Calibration Fie Commants:

Choose a file and Click OK.
This screen will show the
progress.

Pracessing Calibration Yalues

OVERSPEED_RPM

I

Once all parameters have been processed, a
message box will list the compare results. If
the parameters in the file match the
controller, the following message box
appears:

ACT x|
& File hatches Controller

Click OK to close. If there were mismatches, the following message will
appear:

Compare Differences

Controller <> CoNWOODWARDNACT TOOL-APH41MOSTEST ACT Mismatch List

Hame File Controller Units
ACTUATOR FDEK GAIN

0.20001 0.72498 NONE
ACT_FDBK_KFILT 0.801 0.377 NONE
AFE_LOST_DLY 21 20 ms*10
AFE_NO_ANPS 33000 0 nk
APP_AD_ORH 254 1023 adents
APE_AD_ORL 10 0 adents
APP_FULL DEADBAND & 5 adonts
APF_IDLE_DEADBAND & 5 adents
APE_HIN CAL 230.0 240.5 adcats
APE_NOISE CNT 31 30 NONE

APE_RANGE_CAL 550.0 5405 sdents
AUTOCRANK_CRANK_TIME 11.0 10.0 sec
AUTOCRANE_MAX_TRIES 5 6 NONE
AUTOCRANK_NS_TIME 1.0 1.5 sec
AUTOCRANE_REST TIME 16.0 15.0 sec
AUZILIARY_OUTFUT_2_MODE 1 0 HONE
AUXILIARY_OUTFUT_MODE 2 0 NONE
AUZ_ I _LIN 121 120 a2d
AUX_LANP_INRUSH_TIME 4 3 msecx1d
AUZ_OUTEUT 2_RFH 1500.0 700.0 rpm
AUX_OUTEUT_REM 1501.0 700.0 rpm
ERAKE_DEL 1 sec
RANK_2_RUN 1100.0 700.0 rpn
CRANK_DUTY_CYCLE 1.000 0.945 %/100
DERIVATIVE_GALN 0.262 0.250 HOHE
DERIVATIVE_GAIN_IDLE 0.262 0.250 NONE

o

LT

L]
—

You may select "Save to File" if you would like to save a permanent record of the
file compare. You will then be asked to select a destination directory and file
name.

Woodward
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Change APECS Password

This command allows you to add or change a password to protect certain
calibration features. The option is useful, for example, to prevent unauthorized
changes to a known good calibration set in the APECS unit.

By default, the APECS unit is not password protected.
.
To Change APECS Password: el =

1. Choose Calibrate - Change
APECS Password. You will be Please enter the controller password:l*"ﬁ

prompted for the current password.

Change | Cancel | ak, I

IEnter password and click OK.

Statug:

2. The application will query

the controller to verify that
the entered password
matches th epcurrent Please enter the contraller password: I

password. If the password
matches, the “Change”
button is enabled:

Change | Cancel | QK I
Skabuig

IPassword Walid. Click 'Change’ to change controller pazzword

3. Click “Change” and the application will prompt for the new password:

Password Management 5'

Enter new Password: I

Change I Cancel | oK |
Statuz:

IPassword Change Mode.

4. Enter the new password. It should be one word, no spaces, and up to 11
characters long. Once entered, click OK. The application will prompt to
reenter the password to make sure that it was typed in properly:

5. Re-enter the password and click X
OK. If the two entries of the new
password are equal, the new
password will be encoded and Re-enter new passward: ||
saved in the controller.

Passwordg_are upper and lower - Change |  Cancel | o |
case sensitive.

Pazsword Change Mode.
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After changing your password, please record it in a safe place for future
reference. To revert to no password protection, change APECS password to
“peg,” which is the default password.

ACT Operation with the New Password:
Once a password is added or changed, the following calibration features become
password protected:
e Change APECS Calibration
Download Cal File to APECS
Change APECS Password
APECS Calibration Wizard

At the start of any future sessions, ACT will always prompt you to enter the new
password to gain access to these features. You only need to enter the password
once during any session to gain access to all the password protected features.

APECS Calibration Wizard

The APECS Calibration Wizard is an interactive guide to help you get your
controller unit up and running as quickly as possible.

To Calibrate a Controller Unit Using the APECS Calibration Wizard:

1. Choose Calibrate - Calibration Wizard.

2. The Wizard will give you the option to use the default calibration or modify
the existing one. If you select the default calibration, the Wizard will reset all
calibration parameters.

3. Press <Enter> to continue or <Esc> to abort the Wizard.

If you press <Enter> the Wizard will lead you through the calibration process
with a series of questions. When all questions have been answered the
Wizard will ask you to confirm that the values entered are accurate.

4. Press <Enter> to confirm the values, <PgUp> to go back and change the
values, or <Esc> to abort the Wizard.

If you press <Enter>, the APECS Wizard will download the new calibration
and reset all APECS parameters. This will complete the APECS Wizard
operation.

The APECS Calibration Wizard only covers basic calibration. It does
IMPORTANT not automatically assure optimum engine operation. Please refer to

APECS Calibration Procedures for more information.

5. You are now ready to run your engine. Press any key to go directly to the
Parameter Plot screen where you can adjust the PID gains.
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Monitor Menu

The Monitor Menu allows you to observe engine and APECS operation in real
time. The following commands are available under the Monitor Menu.
Parameter View

Parameter Plot

Display Faults

Control Strategy

Parameter List

Parameter View

This command allows you to view certain operating variables (i.e., engine speed)
inreal time.

To View Parameter Values in Real Time:

g [ 3]

1. Choose Monitor > Parameter View. — : —
The application will launch the view e I

25606 rpm

tpe_dutycycle 0.09433 NONE
screen. s | 043771 NONE

2. The screen automatically starts
reading values from the controller and
displaying the values.

3. To stop the updating, click on Stop.
The button name will then change to
‘Start.’ Clicking it again will start updating again.

If any other screen is opened that requires communication with the
IMPORTANT controller while the screen is updating, the Parameter View screen

will be automatically stopped.

Parameter Plot

The Parameter Plot command lets
you view engine performance on
screen in the form of a real-time
graph. This feature allows you to
perturb the system and observe the
response to fine tune engine
performance.

To View Parameter Plot in Real
Time:

Select Monitor - Parameter Plot.
The application will launch and start
the parameter plot view.

[ sep | EAOPORTIONALGAN ‘.mm engine_mem o] imun
G INTEGRAL_GalM I_?rﬂ] n_decied fipm] i?ﬂ? 50
Sgvelofie | DERNATIVE GAIN |_| 7]
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The application will read the previously saved configuration and request the
controller to start sending the parameter values. The controller sends the data to
the PC at a rate that varies with the number of parameters being monitored. The
application uses the Windows timer functionality to update the screen at the
specified rate. Note that if the PC is very busy, the timer accuracy will vary;
therefore, the screen and generated data files should be considered as reference
only.

The X-axis time scale (25 seconds in the example screen) may be shorter than
configured due to the resolution of the monitor. This value will be adjusted when
the graph is resized. This also applies to the print functionality for this screen. All
of the data will be recorded in a revolving buffer for use by the “Save to File”
feature (see below).

The axis scales, parameter names, update resolution and time scale on the
Parameter Plot may be changed as described in the Plot Setup screen.

PID Gain Adjustments from Plot Display Screen

After initial calibration, most engines require only a minor adjustment to PID
gains to fine tune the system to its optimum level. ACT provides a convenient
means of adjusting the PID gains directly from the Plot Display screen.

To Make PID Gain Adjustments from Plot Display Screen:

1. Press the letter <P> for proportional, <I> for integral, or <D> for derivative
gain adjustment. The application will enable the gain you selected.

2. Use the Up or Down arrow keys to increase or decrease the present value.
The arrow keys adjust the values by 0.004. New values may be typed in
directly. Hit <Enter> after you type in a value. The application will save the
new value in the APECS unit.

3. Press the <Esc> to deselect the gain adjustments.

To Change Plot Setup:

This allows you to choose engine rpm, desired engine speed, duty cycle or any
other parameter for viewing real-time plots on screen. Axis scales can also be
adjusted to fit the parameter and/or speed

1. On the Parameter Plot screen, click on “Configure.” The application will show
the following screen with the current values.

x
Plat 2
j |n_des_sw_new j
Az Man I'ID Ais Man |-5
Az Min ID Ais Min I'-‘I
X Awis Time Scale |60 [sec) ® &xis Sample Rate 100 [m-sec]
Cancel | ()8 I

Plot 1/ Plot 2
Use the pull-down to select the desired parameter to plot.

Axis Min / Max
Enter the minimum / maximum value for the parameter value.
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X Axis Time Scale
Controls how much data is displayed on the X axis. This value may automatically
adjust for screen resolution.

X Axis Sample Rate
Controls how often the data from the controller is used to update the screen.
Data received between timer ticks is discarded.

2. Clicking OK will save this information in the Windows Registry so that it will
be remembered the next time the program is started.

The Calibration Wizard will automatically set up the plots if there are
IMPORTANT no saved defaults.

Display Faults

This command allows you to display present faults in real-time. This means if
new faults occur while you are monitoring, the screen will automatically update to
display the current faults. The display will also show historical fault codes that
have been previously logged but do not currently exist. Historical fault codes are
helpful when tracking down intermittent faults.

To Display Faults in Real Time:

Cumert Faully;

1. Choose Monitor - Display Faults
from the main menu. The
application will launch the Fault
view.

The application will update the o
display every time the controller
sends the fault_flags status. This
happens several times a second.

2. Click on the “Pause” button to stop the automatic update of this screen. The
text on the button will change to “Start” and clicking it again will re-start the
automatic updating.

If any other screen requests data from the controller while this
IMPORTANT screen is updating, this screen will automatically Pause.

Control Strategy
This command allows you to check the version of the control strategy in use. This

information may be needed for strategy identification purposes and for future
updates.

Parameter List

The Parameter List screen allows the user to adjust which parameters are
displayed on the Parameter View display.
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To Display the Parameter List:

1. Choose Monitor > Parameter List from the main menu.

2. The F5/F6 keys will backup/advance through the . =
list. Press F9 or click on “On View List” to toggle  rama
the selected parameter on the Parameter View e

screen.

3. Click on the X’ in the title bar or press <Esc> to
close the screen. Edits are not saved between
application launches.

4. If the Parameter View screen is already open b P R
when changes are made to the view list, close FSIPREVONS  [FNERT [POIADD/AEHOVE O View  [ESCICANCEL EDIT/ CLOGE =
the Parameter View screen and re-open it to s ' s
make the changes effective.

Save
Clicking Save will prompt the user for a file name to save the currently viewed
configuration to.

Choose or create a file ko save the view sek 2=l Type in a file name that

Saven: | ) ACT + & oF B reflects the purpose of the

=] engine speeds.av saved Configuration and click
[ error codes.av Save. The view configuration

dialog will now display the
selected file name in the title

bar.
Open
Clicking Open will prompt the
Fil g i :
Boss fMiesed [ 5= | userforafie name ofa
Save as type: IACT iew Setup Files [%.avf) j Cancel |/ preViOUSIy Sa.Ved V|eW
” Configuration.

Select the desired file and click Open. The View Configuration will be updated
with the saved parameters.

The ACT application will always recall the default set of plot configuration
parameters at application startup, and does not recall the last used view setup
file. So the view configuration will always start with the default view.

Several parameter view screens can be open with different configurations by
changing the configuration on the parameter list screen (F9 or Open), then
opening a new Parameter View.

Only one of the parameter view screens can be monitoring the
IMPORTANT controller at once.
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Configure Menu

Configure Serial Port

This command allows you to designate the proper COM port for your PC to
enable communication between the ACT and the APECS controller.

To Configure the Serial Port:

1 From the main menu screen ALT Communications Configuration ﬂ
choose Conﬁg_'-»lre_9 CUStom Serial r— Serial Controller Connection— — Demao Mode
Port. The_appllcatlon will display  Com 1  EPS 1000 Cancel |
the following screen:  Com? @ £FEES 500

. .  Cush & APECS 3000

2. Choose a port and Click OK. This wor | -
screen will be displayed on ?PEES mE
application startup if a controller Ll "
cannot be found at the last selected " APECS 5000

port and can be changed any time
after the application has started.

Demo Mode
This mode will use a calibration file “Demo.000” and use random numbers for
values requested from the controller.

COM1/COM2

This mode will look for a controller attached to the selected serial port. An error
message will be displayed AFTER you click OK if a controller cannot be found or
if the port cannot be opened.

COM ports outside of this range can be used by editing the default COM port
registry key for this application.

Help Menu

The Help Menu provides access to the online user’'s manual and other
information helpful to your use of the Calibration Tool. The following commands
are available under the Help Menu:

e Help Topics

e About ACT

e User's Manual

Help Topics

This command allows you to search for specific information by displaying
software menu items or through key words.

1. Click on “Contents” for an outline of the software applications listed by menu
items.

2. Click on “Index” or “Find” to locate a specific topic through an alphabetical
listing or by typing in a word or phrase.

3. Follow the on-screen commands to page through the manual.
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About ACT

This command displays the version of the calibration tool that you are currently
using. This information is important for tool identification purposes and for
servicing support.

User’'s Manual

This command accesses the User’'s Manual, which includes comprehensive
information on the APECS 4500 controller, wiring diagrams, ACT software
menus, and calibration parameters. The manual may be viewed online or printed
for future reference.
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Chapter 4.

CAN Oeeration

CAN Communications

To use CAN (Controller Area Network), the APECS 4500 version that supports
CAN must be purchased. The APECS 4500 can provide either J1939 or
customer specific protocol, depending on the version purchased.

CAN Connections
CANL (J1-6) and CANH (J1-7) lines are used for CAN communications.

As a general rule for CAN networks, use the following and refer to the table
below.

e Wiring length restrictions depend on the baud rate used and the APECS
4500 only supports 250 kbps.

e The “Trunk” is the length between the two units at the physical ends of
the network; or the two termination points if the end units have a drop
cable.

e The “Cumulative Drop” is the added length of all drop wires from the
trunk to the devices.

e The “Maximum Drop” is the maximum allowed for any 1 drop.

The limits below are the maximum allowed by the CAN standard, when isolated.
Shorter lengths in practice are highly recommended in order to maintain a high
level of reliability.

Since APECS 4500 CAN communications is not isolated, a distance
IMPORTANT of 40 meters should not be exceeded without adding an isolator.

CUMULATIVE MAXIMUM
BAUD RATE | TRUNK LENGTH et ek
250 kbps 250 m (820 ft) 78 m (256 ft) 6 m (20 ft)

CAN Network Termination

CAN networks must be terminated with a 121 Q +1% differential resistance at
each end of the network. It is necessary to terminate the network to prevent
interference caused by signal reflections. Depending on length, may CAN
networks will not operate at all without the proper termination. Generally it is
recommended not to build the termination into a node since CAN is intended to
be a plug-n-play type network with RIUP (remove and insert under power).
However, no specific restrictions are placed on the inclusion of termination
resistors in a node.

Termination resistors must be installed only at the physical ends of the network.
Terminating other midpoint units can overload the network and stop all
communications. As a rule, no matter how many units are on a network, there
should never be more than two terminations installed.

Termination is a simple 121 Q, 2 watt, 1% metal film resistor placed between CAN
high and CAN low terminals (differential termination) on or near the two end units.
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CAN Network Construction

While there are a number of different ways to physically connect devices on a
network, the most reliable method for multi-drop networks is a “daisy chain”
configuration also called a “zero drop length” connection. A “backbone with
stubs” is also acceptable, but will require more attention to wiring for reliable
performance. In a daisy chain, wires are run from device one to device two to
device three, etc. In a backbone with stubs, a main trunk line is run between the
two devices that are physically farthest apart, and then stub lines are run from
the intermediate devices to the trunk line. Stubs should be kept as short as
possible and may never exceed 6 m (20 ft). See wiring example below for a
graphical representation.

In most applications, a ground wire is needed between all units on the network.
The preferred method for isolated ports is to include a separate wire in the CAN
cable. This keeps the communications and ground reference at the same
potential at all times. For this reason the recommended cable types below are
DeviceNet™ * cables, which include an extra wiring pair.

*—DeviceNet is a trademark of Open DeviceNet Vendor Association, Inc. (ODVA).

Non-isolated nodes may not have a signal ground available for connection. If a
signal ground is not available, use the alternate wiring scheme of connecting the
CAN ground wire from the isolated nodes to the B- terminal at a non-isolated
node (this is typically the signal reference for CAN if isolation is not provided).

Zevo Length Deop Line

MNode
—LJ_ Mode Trusk Ene Terminating
Muliigle Mode Mslti_Port e Resisior
Bmnchang - Tap J:]
Drop Line [ —I
N j
Minde
7 M
ultple Mode
Nod Mode | Drop Ene Diaxisy Chain
Node | Deop Line
Terminating Modde
E“'f R gaspor '——If
L
Ny |—
Node /s
~ Dwoge T
Mode MNode

Short Drop Lnes (& m20 i)

“_-w—_-""

Figure 4-1. CAN System Wiring Example
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CAN Cable Recommendations

In industrial environments, where CAN leaves the engine frame, use only
recommended shielded cabling for a CAN network. Correct cable is available
from Belden, Lapp Cable, or other suppliers providing an equivalent cable. Here
are the cable specifications from the DeviceNet standard, a good source for CAN
requirements.

Data pair impedance | 120 £10% AT 1 MHZ

Cable capacitance | 12 pF/ft at 1 kHz (nominal)

Capacitive unbalance | 1200 pF/1000 ft at 1 kHz

Propagation delay | 1.36 ns/ft (maximum)

DC resistance | 6.9 Q /1000 ft @ 20 °C (maximum)

19 strands, 1.0 mmz corresponds to 18 AWG,

Data pair | yividually tinned, 3 twists/foot

19 strands, 1.5 mm2 corresponds to ~16 AWG,

Power pair individually tinned, 3 twists/foot

19 strands, tinned copper shielding braid or

Drain / shield wire shielding braid and foil

Cable type | Twisted pair cable, 2x2 lines

20 x diameter during installation or 7 x diameter

Bend radius fixed position

0.13 dB/100 ft @ 125 kHz (maximum)
Signal attenuation | 0.25 dB/100 ft @ 500 kHz (maximum)
0.40 dB/100 ft @ 1000 kHz (maximum)

“DeviceNet” cable is a good example of CAN cable but caution should be used
as most DeviceNet cables are not rated for on-engine temperatures.

When using DeviceNet cables, use only the “Thick” or “Trunk” cable. The
advantage of “Thick” cables is the conductor size. Larger gauge conductors fare
much better in high vibration environments.

Below are DeviceNet CAN cables that are suitable for on-engine use if the wiring
area stays below 75 °C. Other cables may exist.

PART NUMBER DESCRIPTION

PVC, 18 AWG shielded data pair, 15 AWG shielded

Belden 3082A power pair, 300 V insulation

PVC, 18 AWG shielded data pair, 16 AWG shielded

Belden 7896A power pair, 600 V insulation

Halogen free, 18 AWG shielded data pair, 15 AWG

Lapp Cable 2710-250 | (o 1o power pair, 300 V insulation

CAN Shielding

Shielded cable is required for industrial applications. Only very cost sensitive
automotive applications attempt to use unshielded cable for communications.
Unshielded cables and improperly shielded cables are likely to cause
communication problems and unreliable control operation. The standard for CAN
networks is that each device will have an AC-coupled shield connection
(connected through a 0.01 uF coupling capacitor) and a single shield ground
location. The ground location does not have to be at a unit connector; it can be
any convenient place in the system but should be the same ground as used for
the system power.
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YES I
Other
Units On
CAN Bus Shiglded Twisted-Pair [STP)
YES Il
Other
Units On
&M Bus Shiglded Twistzd-Fair (STF)
NO Il
Crther
Units On . P ap—
CAN Bus Shielded Twisted-Pair (STP)
NO Il
Other
Units On . . [ —
CAM Bus Shielded Twisted-Pair {5TF)

Figure 4-2. CAN Shielding

CAN Basics

Data messages transmitted from any node on a CAN bus do not contain
addresses of either the transmitting node, or of any intended receiving node.
Instead, the content of the message is labeled by an identifier that is unique
throughout the network. All other nodes on the network receive the message and
each performs an acceptance test on the identifier to determine if the message,
and thus its content, is relevant to that particular node.

If the message is relevant, it will be processed; otherwise it is ignored. The
unigue identifier also determines the priority of the message. The lower the
numerical value of the identifier, the higher the priority. In situations where two or
more nodes attempt to transmit at the same time, a non-destructive arbitration
technique guarantees that messages are sent in order of priority and that no
messages are lost.
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Error Handling

The error handling of CAN is one of the really strong advantages of the protocol.
The error detection mechanisms are extensive and the fault confinement
algorithms are well developed. The error handling and retransmission of the
messages is done automatically by the CAN hardware.

The error handling aims at detecting errors in messages appearing on the CAN
bus, so that the transmitter can retransmit an erroneous message. Every CAN
controller along a bus will try to detect errors within a message. If an error is
found, the discovering node will transmit an Error Flag, thus destroying the bus
traffic. The other nodes will detect the error caused by the Error Flag (if they
haven't already detected the original error) and take appropriate action, i.e.
discard the current message.

Fine Fault Confinement

A faulty node within a system can ruin the transmission of a whole system, by
occupying all the available bandwidth. The CAN protocol has a built-in feature
that prevents a faulty node from blocking the system. A faulty node is eventually
excluded from further sending on the CAN bus.

Bit-wise Arbitration

The priority of a CAN message is determined by the numerical value of its
identifier. The numerical value of each message identifier (and thus the priority of
the message) is assigned during the initial phase of system design.

The identifier with the lowest numerical value has the highest priority. Any
potential bus conflicts are resolved by bit wise arbitration in accordance with the

wired-and mechanism, by which a dominant state (logic 0) overwrites a recessive
state (logic 1).

APECS 4500 CAN Specific

Parameter Format

The APECS 4500 uses a Little-Endian format when handling multiple-byte
parameters (i.e. a position demand of 50% is $FFOF, not $0FFF). All parameters
shall use this format unless otherwise specified.

CAN Bit Timing

The APECS 4500 bit timing is limited to provide a data rate of 250 kbps only.

CAN Fault Indication

When the EXTERNAL_ANALOG_MODE is configured to receive demanded
speed from CAN, if new demanded speed updates are not received within the
configured CAN_LOST_DELAY a CAN_DEFAULT_SPEED is taken. There is no
fault indication.
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J1939

This section describes the communication that will take place over the J1939
Data Link when the optional CAN communication link is used and the protocol is
configured for J1939. For details on this protocol, see SAE J1939/11.

Data Frame
The APECS 4500 uses CAN 2B with 29-bit identifiers.

The Data Frame is the most common message type. It comprises the following
major parts:

e The Arbitration Field which determines the priority of the message when
two or more nodes are contending for the bus. The Arbitration Field
contains: a 29-bit Identifier (which also contains two recessive bits: SRR
and IDE) and the RTR bit.

e The Data Field which contains zero to eight bytes of data.

e The CRC Field which contains a 15-bit checksum calculated on most
parts of the message. This checksum is used for error detection.

¢ An Acknowledgement Slot. Any CAN controller that has been able to
correctly receive the message sends an Acknowledgement bit at the end
of each message. The transmitter checks for the presence of the
Acknowledge bit and retransmits the message if no acknowledge was

detected.
ACK
Lhitration 3lot
Field Contml End of
Field Lata Field CRC Field Frame
| Identifier Identifier | | | |_| | | |
+ + e ¥ *ACK
Start of SRR IDE RTER. Delimiter  Delimiter
Frare

Figure 4-3. CAN 2.0B Data Frame

Device Identifier

The Device Identifier is a not configurable parameter. The default value contains
manufacturer code — Woodward Governor identifier: 153. All the others fields are
set to 0. Moreover CAN Source Address cannot be changed by Address Claim
Procedure. The default value is set to 0x00. It means that only one APECS 4500
controller can exist on a single CAN link. If it is required (another device uses the
same source address) APECS 4500 CAN Source Address parameter can be
modified by ACT Tool.

Transmitted and Received CAN Messages

The following information is sent over the CAN:
e Engine Related Parameters
e Vehicle Battery Status
¢ Engine Shutdown Request

The following information is sent over the CAN upon request:
e Address Claim

The APECS 4500 CAN Controller receives the following information over CAN:
e Speed Setpoint

e Address Claim
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Supported Frames

e PGN 61444 Electronic Engine Controller 1 - EEC1

Engine related parameters.

Transmission Repetition Rate: 20 ms

Data Length: 8

Default Priority: 3

Parameter Group Number: 61444 (0xF004)

Start Position Length Parameter Name SPN
4-5 2 bytes Engine Speed 190
7.1 4 bits Engine Starter Mode 1675

Engine Starter Mode SPN assumes starter motor sense at SW2 input.

e PGN 61443 Electronic Engine Controller 2 — EEC

Identifies electronic engine control related parameters.
Transmission Repetition Rate: 50 ms

Data Length: 8

Default Priority: 3

Parameter Group Number: 61443 (0xF003)

Start Position Length Parameter Name SPN
1.1 2 bits Accelerator Pedal 1 Low Idle Switch 558
2 1 byte Accelerator Pedal Position 1 91

« PGN 65271 Vehicle Electrical Power 1 - VEP1

Transmission Repetition Rate: 1 s

Data Length: 8

Default Priority: 6

Parameter Group Number: 65271 (OXFEF7)

Start Position Length Parameter Name SPN
7-8 2 bytes Keyswitch Battery Potential 158

e PGN 65252 Shutdown — SHUTDN

Transmission Repetition Rate: 1 s

Data Length: 8

Default Priority: 6

Parameter Group Number: 65252 (OXFEE4)

Start Position Length Parameter Name SPN
4.1 2 bits Engine Wait to Start Lamp 1081

This assumes glowplug feedback present on PTO input and lamp relay on AUX2 output.

« PGNO (R) Torque/Speed Control 1 - TSC1

Data Length: 8
Default Priority: 3
Parameter Group Number: 0 (0x0)

Start Position Length Parameter Name SPN
2-3 2 bytes Engine Requested Speed/Speed Limit 898

This frame is preceded by the unit only when EXTERNAL_ANALOG_INPUT is set to 40
(CAN Input). Otherwise this frame is ignored by the unit.

If this frame is not received by unit within the configured CAN_LOST_DELAY, desired
speed will go to CAN_DEFAULT_SPEED.
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PGN 61183 ADDR_CLAIM

Transmission Repetition Rate: After Power-up, On Demand
Data Length: 8
Parameter Group Number: 61183 (OXEEFF)

Start Position Length Parameter Name
3.6 11 bits Manufacturer Code

This frame is sent by the unit at the start or on demand from the master. Value of
“Manufacturer Code” is always set to 153. This value is dedicated to Woodward Governor
Company. The other values in this frame are set to 0.

PGN 60159 (R) ADDR_CLAIM

Data Length: 3
Parameter Group Number: 60159 (OXEAFF)
Data = [0x00, OXEE, 0x00]

When the unit receives this frame from the master then ADDR_CLAIM frame is sent by the
unit.
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Chapter 5.

Calibrating APECS Features

Calibration Guide

This chapter explains the procedures for calibrating (configuring and adjusting)
the various APECS 4500 features to work with your application.

Before proceeding, make sure you have completed the installation of all the
required hardware for your system and are familiar with using the APECS All-
purpose Calibration Tool (ACT).

Safety Precautions

The APECS 4500 is a user configurable engine speed governor and will follow
your settings and commands immediately. Please be aware of this when
calibrating and entering values in the unit.

It is possible to enter values in the APECS unit that are in excess of what
the engine is capable of performing and outside of safe operating range.

It is the user’s responsibility to be accurate when entering data into the APECS
or the ACT. Entering values outside of safe operating range can result in serious
physical injury and/or damage to the equipment or application.

| An overspeed shutdown device, independent of the APECS system,
should be provided to prevent loss of engine control that may cause
personal injury or equipment damage.

Calibration Categories

To incorporate any of the programmable features in your system, a set of
parameters associated with each feature must be calibrated using the calibration
tool (ACT). These parameters are grouped under various categories under the
Calibrate Menu in ACT. (Refer to Table 3 below.)

Table 5-1. Calibration Categories and Features

CékerE%Ac;l'lquiN FEATURES AVAILABLE
Governor Gain PID Gain Settings
Engine Set Speed External Pot Calibration
Speed Input Speed Input Calibration
Engine Start Autocrank, Glowplugs
Diagnostics Sr\geures(,:p;%id/Underspeed
Actuator Output Actuator Current Protection
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IMPORTANT

that will work with many applications.

Calibrating an APECS Unit

Once the system set-up is complete it is fairly easy to calibrate an APECS 4500
controller.

Before proceeding with calibration, please ensure that the controller unit is
connected to the COM port and powered.

Follow the steps below for calibrating your APECS controller unit.

1.

If an icon for the Calibration Tool exists, double click on it to start the ACT
software.

If no icon exists, click on the Start button, highlight “Programs,” find the ACT
software and click to start it.

Make sure the COM port designation in ACT matches the serial port on the
back of your PC.

Follow the procedure outlined in the Configure Menu to change the COM
port assignment, if needed.

If you do not use the Wizard, calibrate the speed input for the type of speed
sensor, SPEED_TYPE as well as the appropriate values for

PULSES _PER_REV and PULSES_PER_UPDATE. Refer to “Speed Input
Configuration Parameters”.

If you wish to use the Wizard for basic calibration, refer to “APECS
Calibration Wizard.” The Wizard is an interactive guide to help you get your
controller running as quickly as possible.

Beyond basic calibration, there are many parameters associated with
APECS that can help enhance the performance of your engine. Read the
section on “Understanding APECS Calibration Parameters” and decide on
the parameters you would like to adjust.

Access “Change APECS Calibration” option from the Calibrate menu and
select the desired parameter from the appropriate category. Adjust the value
of the parameter as needed.

Repeat Step 5 until all desired parameters have been adjusted and
satisfactory engine performance has been achieved.

You do not need to save the new calibration settings. All settings are
automatically saved in the controller and remain in memory after shutdown.
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Saving a Calibration Set to File

After satisfactory engine performance is achieved, it is recommended that you
save the calibration set to a file.

e A saved file allows you to experiment with other calibration settings and still
be able to recall the saved calibration set.

e A saved calibration set can be used for configuring additional APECS units.

To Save a Calibration Set to File:

1. Access the File Menu to activate the “Save APECS Cal to File” command.

2. Enter afile name to save the calibration data to a designated file.

3.  When prompted to edit the comment list, enter information that will help you
keep track of specific engine, application and environment data associated

with the file.

4. ACT will save the calibration set and automatically append the file extension
“.ACT" to the file name.

Calibrating an APECS Unit with a Saved Calibration File

You may wish to calibrate additional APECS units with a saved calibration file for
consistent, optimized operation.

To Calibrate an APECS Unit with a Saved Calibration File:

1. Access the Calibrate menu to activate the “Download Cal File to APECS”
command.

2. Select the appropriate file to download (refer to the comment list on the right
side of the screen to help identify the desired file). Enter password if
prompted.

3. ACT will download file calibration to APECS permanent memory.

4. Repeat Steps 1 and 2 if multiple APECS units are to be calibrated.

The APECS unit must be powered up, but need not be mounted on
IMPORTANT the engine to carry out the calibration procedure.

Understanding APECS Calibration Parameters

This section provides answers to frequently asked questions about calibration
parameters, lists parameters, and provides calibration procedures.
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Frequently Asked Questions

What is a calibration parameter?

A parameter is a numerical value that helps the calibrator adjust or set the
APECS controller. Once fixed by a calibrator, the parameter is not subject to
change while the system is operating. APECS calibration parameters are used
not only to adjust and set the controller but also to configure it properly for
different applications.

Why do we need to calibrate the APECS system?

APECS 4500 is a software programmable system and has no manual
adjustment. Calibrating is the only means of configuring and adjusting the
controller for your specific application.

Do I need to calibrate ALL the parameters to make my system work?

No. Two parameters, PULSES PER_UPDATE and PULSES PER_REV, are
factory set to prevent the APECS unit from calculating an engine speed and
driving the actuators. These two parameters must be calibrated to a non-zero
value before normal APECS operation can begin. Other parameters are preset to
values that will work with many engines and applications. However, it is
recommended that you review all settings for your own application.

Is it possible to enter values in APECS in excess of what the application is
capable of performing?

Yes. While ACT (the calibration tool) restricts you from entering values outside of
the specified range, the range itself is fairly wide and it is possible to enter values
in excess of what your application is capable of performing.

For example, it is possible to command engine speeds up to 8192 rpm with ACT.
Your engine may or may not be able to operate at this speed. It is also possible
to damage the generator or pump attached to your engine by commanding
maximum engine speed because while the engine may be capable of performing
at the rated rpm, the generator or pump is likely to have a lower rpm rating than
the engine.

Furthermore, there are certain parameters that are used to properly configure an
application. Entering incorrect values for these parameters will result in improper
configuration and may make the engine run at maximum throttle. Entering values
outside of safe operating range can result in serious physical injury and/or
damage to the equipment.
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List of Most Important Parameters

CATEGORY PARAMETER DESCRIPTION FA%I\CL)RY
DERIVATIVE_GAIN Speed stability 1
e INTEGRAL_GAIN Steady state speed 2
Gain
Calibration PROPORTIONAL_GAIN Transient response 5
MASTER_GAIN Combined PID gain 1
response
Delay for return to
BRAKE_DELAY idle. mode 023 15
EXTERNAL_ANALOG_MODE External analog 0
input configuration
RAMP_DOWN_RATE Engine speed ramp 1000
down rate
RAMP_UP_RATE Engine speed ramp 1000
- = up rate
SET_SPEED_1 Engine set speed 1 1800
SET_SPEED 2 Engine set speed 2 1900
SET_SPEED 3 Engine set speed 3 2000
SET_SPEED 4 Engine set speed 4 2500
Engine Set :
Speed SET_SPEED_MAX Maximum 2600
> . increment speed
Calibration —
SET_SPEED_MIN Minimum 1000
decrement speed
SET_SPEED_TRIM Engine analog trim 200
- - speed (rpm)
SET_SPEED_WARMUP Engine warm up 1800
speed
Multi-speed
SPEED_DECREASE_DELAY decrease delay 0
time (sec)
SWITCH_CONFIGURATION 1,2,3,4: multispeed, 1
- 5: variable speed
WARM UP TIME Time spent at warm 0
- = up speed
Mag Pickup = 128
Coil Ignition = 2
SPEED_TYPE 128
Magneto = 3
ez Hall Effect = 131
Input
Configuration PULSES_PER_REV No. .of pulses per 0
engine revolution
No. of pulses until
PULSES_PER_UPDATE next engine speed 0
update
Engine Start Time autocrank
Calibration AUTOCRANK_CRANK_TIME holds crank 5
solenoid on (sec)
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CATEGORY

PARAMETER

DESCRIPTION

FACTORY
CAL

AUTOCRANK_MAX_TRIES

Number of
autocrank attempts

6

AUTOCRANK_REST_TIME

Rest time between
autocrank attempts
(sec)

CRANK_DUTY_CYCLE

Kickoff duty cycle
for open-loop
cranking

0.945

GLOWPLUG_TIME

Time glowplugs
pre-heat before
autocrank

KEY_ON_DUTY_TIME

Time at no-start
and key-on to drive
duty cycle

Diagnostics
Calibration

ENGINE_PROTECT RUN_TIME

Engine run time
before checking
switch (8000 =
disabled)

8000

ENGINE_PROTECT_TIME

Switch delay before
engine protection
shutdown

1000

OVERSPEED_RPM

Actuator shutdown
speed (max)

UNDERSPEED_RPM

Actuator shutdown
speed (min)

UNDERSPEED_RUN_TIME

Run time before
underspeed is
checked

10

Actuator
Output
Calibration

AUX_OUTPUT_RPM

Drive aux. output
when above this
engine rpm

700

AUX_OUTPUT 2_RPM

Drive aux. output
#2 when above this
engine rpm

700

AUXILIARY_OUTPUT_MODE

: no output

:use RPM

: critical shutdown
PTO

: autocrank

> mimic LED

: glowplug

AUXILIARY_OUTPUT_2_MODE

: no output

use RPM

. critical shutdown
PTO

: autocrank

> mimic LED

: glowplug

OCURAWNRO|OUDWNRO

DROOP_PERCENT

X

HIGH_ACTFDBK_LMX

Actuator current limit

8000
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Calibration Procedures: PID Gains Adjustment

These parameters allow proportional, integral and derivative gains to be
programmed by the user.

Calibration Parameters Needing Configuration:

DERIVATIVE_GAIN
Engine speed governor derivative gain (unitless).

Derivative gain is used to improve stability. Increase derivative gain until
response has a slight overshoot on load transients.

INTEGRAL_GAIN
Engine speed governor integral gain (unitless).

Integral gain is used to remove steady-state errors. Increase integral gain until
speed begins to oscillate, and then decrease until oscillation stops. If oscillations
do not occur, bump actuator lever, then decrease integral gain until oscillation
stops.

PROPORTIONAL_GAIN
Engine speed governor proportional gain (unitless).

Proportional gain is used to improve response time. A maximum amount of
proportional gain should be used while still maintaining stability. Increase
proportional gain until speed begins to oscillate, then decrease until oscillation
stops. If oscillations do not occur, bump actuator lever, then decrease
proportional gain until oscillation stops.

MASTER_GAIN
As a multiplier to the PID gains, master gain is used to increase or decrease the
combined derivative, integral, and proportional response with a single gain.

For example, the effective proportional gain used is PROPORTIONAL_GAIN X
MASTER_GAIN. This permits adjusting all three gains with a single calibration
parameter. Range: 0-255. Default value: 1.0.

PID Gain Settings Response Plots

ACT allows the user to adjust the P, I, and D gain settings and observe the
response directly on screen in the form of a real-time plot. The plots on the
following page illustrate the various conditions a user may encounter while tuning
an application. Although conditions may vary according to application and nature
of load, these plots are typical of what is often observed.

Figures 5-1 through 5-5 illustrate less desirable conditions often encountered
while tuning an application and suggest probable causes.

Figure 5-6 shows a plot of a properly tuned application. Although conditions may
vary according to application and nature of load, this plot is typical of what is
often desired.
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Desired RPM \ Desired RPM\\
RPM —_—— e — e RPM —f—
Actual RPM j _)
Actual RPM

TIME TIME

Figure 5-1. PID Gains Too Low Figure 5-2. PID Gains Too High
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Figure 5-3. Integral Gains Too Low Figure 5-4. Derivative Gains Too High
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Figure 5-5. Integral Gains Too High or
Derivative Gains Too Low Figure 5-6. Desirable Response

Excessive friction and slop in the linkage are primary contributors to
IMPORTANT poor governor stability. If it is not possible to stabilize engine

performance, check smoothness of the linkage.

Engine Set Speed Calibration Parameters

Calibration Procedures
The APECS 4500 has two primary means of selecting engine speed setpoint:

Using analog speed setpoint (EXTERNAL_ANALOG_MODE)
Using switched speed setpoint (SWITCH_CONFIGURATION)

To make the controller suitable for many mobile and stationary applications,
there are a variety of ways the speed switches and the speed pot can be
configured (e.g., independently or together).
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Calibration Parameters Needing Configuration:
The two primary parameters are:

EXTERNAL_ANALOG_MODE
This is the main parameter that defines how the analog APP input is interpreted
for selecting desired engine set speed.

Speed selection may be based on the analog input, the speed select switches, or
a combination of the two. See Table 5-2, External Analog Input Modes.

SWITCH_CONFIGURATION
This parameter is used to let the software know how the user has configured the
speed switch inputs.

Calibrate SWITCH_CONFIGURATION according to the selected speed mode.
There are five switch configurations available: Single Speed, Two Speed, Three
Speed, Four Speed, and Variable Speed. See Table 5-3, Switch Configuration
Modes.

Parameters Used with the Two Primary Parameters:

BRAKE_DELAY

When external analog mode is set to 23, 123 or 223 this parameter is used to
specify the delay, in seconds, for automatic return to idle once the IVS input
indicates no load on the engine.

Range: 0-31.875 seconds. Once the timer times out, SET_SPEED_MIN will be
commanded, regardless of whether the controller is in pedal mode or PTO mode.

BRAKE_UP_RATE"

When external analog mode is set to 23, 123 or 223, this parameter defines in
rpm/second the speed at which command engine speed decreases to idle speed
after brake input is activated.

BRAKE_DOWN_RATE*

When external analog mode is set to 23, 123 or 223, this parameter defines in
rpm/second the speed at which command engine speed increases back from idle
speed after brake input is released.

RAMP_DOWN_RATE
Rate at which command engine speed decreases from one set point to a lower
set point (rpm/second)

RAMP_UP_RATE
Rate at which commanded engine speed increases from one set point to a higher
set point (rpm/second)

SET_SPEED 1
Preset engine speed 1 (rpm). Used when SWITCH_CONFIGURATION = 1-4

SET_SPEED_2
Preset engine speed 2 (rpm). Used when SWITCH_CONFIGURATION = 2-4

SET_SPEED_3
Preset engine speed 3 (rpm). Used when SWITCH_CONFIGURATION = 3-4

SET_SPEED 4

" This feature is present only in some APECS 4500 versions. See Table 1-1 for details.
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Preset engine speed 4 (rpm). Used when SWITCH_CONFIGURATION =4

SET_SPEED_MAX
Highest engine speed command possible when using push-button switches to
ramp engine speed up (rpm). (SWITCH_CONFIGURATION = 5)

Also used to specify the maximum rpm commanded with an analog input.

SET_SPEED_MIN
Lowest engine speed command possible when using variable speed mode to
ramp engine speed down (rpm). (SWITCH_CONFIGURATION = 5).

Also used to specify the minimum rpm commanded with an analog input.

SET_SPEED_TRIM
Amount speed may be trimmed with external pot above/below set speed.

SET_SPEED_WARMUP

Engine speed set point used immediately after engine has started running (rpm.)
For drive by wire modes, this speed is treated as minimum pedal speed. It is
ramped towards SET_SPEED_MIN in WARMUP_TIME.

SPEED_DECREASE_DELAY

When in multi-speed mode 2, 3, or 4 and the speed switch input is changed to
select a lower speed, this is the delay before the engine speed command is
ramped to a new lower speed (seconds).

This is useful for applications that are continuously switched on and off such as
welding machines.

WARMUP_TIME

Length of time (seconds) to hold engine at warm-up speed immediately after
engine has started running after controller power-up. Setting WARMUP_TIME to
zero disables the warm-up feature

All switch inputs (except EPSW) are switched to Vbat.
IMPORTANT
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External Analog Input Calibration (with IVS)

Use the external analog input for a variety of functions such as (1) Pedal position
sensor with idle verification switch, (2) Remote speed adjustments, and (3) Trim
potentiometer. See “Auxiliary Output Wiring” for wiring analog inputs.

Table 5-2. External Analog Input Modes

MODE

CONFIGURATION

DESCRIPTION

000

No external analog input

Use speed switch or momentary switch.

1 Trim mode Use external pot or voltage input to trim the
00 selected set speed. The speed selected by the
set speed switches is adjusted by plus or
Trim mode, reverse potl minus SET_SPEED_TRIM. The set speed is
101 bounded by SET_SPEED_MIN and
SET_SPEED_MAX.
002 Set speed with pot
Use external pot to adjust set speed between
012 Set speed with pot, PTO SET_SPEED_MIN and SET_SPEED_MAX.
available PTO is available where indicated and allows
switching from pot selected speed to switch
Set speed with reverse selected speed. Auxiliary output can be
102 pot configured to indicate the PTO state.
Ramp rate limits are still in effect.
112 Set speed with reverse
potl, PTO available
003 Drive-by-wire, no IVS
013 Drive-by-wire, no IVS, Use pedal pot to adjust set speed between
PTO available SET_SPEED_MIN and SET_SPEED_MAX
with additional fault management. If IVS is not
. . used, controller must see minimum pedal
103 | Prive-by-wire, IVS closed position after power-up before command for
atidle off-idle will be accepted.
Can be used with an IVS (idle verification
113 Dri_ve-by-wire, IV_S closed switch).
atidle, PTO available PTO is available where indicated and allows
switching from pedal pot selected speed to
Drive-by-wire, IVS open at switch selected speed. Auxiliary output can be
203 idle configured to indicate the PTO state.
Ramp rate limits are still in effect.
213 Drive-by-wire, IVS open at
idle, PTO available
62 Woodward
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Table 5-2. External Analog Input Modes (cont'd.)

Uses IVS as brake input—will do automatic
Drive-by-wire, PTO return to idle (SET_SPEED_MIN) when IVS is
available, brake mode active for longer than BRAKE_DELAY seconds.
Otherwise, similar to Mode 013.

023

(Not present in all APECS versions)
Uses IVS as brake input, SW1 as auto idle
on/off switch, otherwise similar to mode 002

1232 | Auto-idle, potentiometer
reverse acting!

(Not present in all APECS versions)
Uses IVS as brake input, SW1 as auto idle
on/off switch, otherwise similar to mode 102

Auto-idle, potentiometer

2
223 forward acting

Uses value provided by VCU (Vehicle Control Unit)
040 | CAN input by CAN interface to adjust speed. This mode
disables other external analog input modes.

APS calibration mode. Allows an external pot from various applications to
255 | See “External Pot interface properly with the controller.
Calibration”

(1) Reverse pot option reverses speed increase/decrease relationship to a clockwise
rotation of pot.

(2) This mode is available only in some APECS 4500 versions. See Table 1-1 for details.

If a drive-by-wire mode is being used (003, 013, 023,

103, 113, 203, 213), the engine is not allowed to start
NO TICE up in PTO mode.

PTO is locked out until the engine has started and the
PTO switch is transitioned from its off position.

Switched analog speed ranges and governor gains*

This feature allows analog speed range and governor gains to be altered by the
three switched inputs. Refer to the wiring diagram instructions for details on
connecting the switches.

If this feature is enabled, switched inputs retain its other functionalities (unless
disabled by configuration).

Calibration parameters needing configuration

SW_OPTIONS2
When calibrating this feature, following bits (counting from 0) should be
considered:

e Bit3 — controls speed range switch 1 polarity. If this bit is written O,
speed range switch is considered activated with input short to
ground. Otherwise, it is considered active with switch released.

e Bit4 — entering “1” enables switched governor gains

e Bit6 — entering “1” enables switched analog speed ranges

" This feature is present only in some APECS 4500 versions. See Table 1-1 for details.
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For example, if all other bits SW_OPTIONS?2 are to be set to zero, both switched
analog speeds and switched governor gains will be enabled when with writing
value “01010000".

Note that remaining bits in this parameter control various other features and
should be left unchanged when calibrating switched analog speed ranges
(default is zero).

SET_SPEED_MAX_1 ... SET_SPEED_MAX_3

SET_SPEED_MIN_1 ... SET_SPEED_MIN_3

These parameters define the speed ranges that will be used instead of
SET_SPEED_MIN and SET_SPEED_MAX when given speed range switch is
active. if two or more speed range switches are active simultaneously, low speed
range will be equal to highest SET_SPEED_MIN_n value configured for active
switches, high speed range will be equal to lowest SET_SPEED_MAX_n value
configured for active switches.

SPD_RANGE_UP_RATE, SPD_RANGE_DOWN_RATE

These values define rates in rpm/second at which speed increases/decreases
when changing speed range results changed desired speed for the given analog
input value.

P_SWITCHED_GAIN_1... P_SWITCHED_GAIN_3,

|_SWITCHED_GAIN_1... |_SWITCHED_GAIN_3,

D_SWITCHED_GAIN_1... D_SWITCHED_GAIN_3,

These are governor gain values that are used instead of
PROPORTIONAL_GAIN, INTEGRAL_GAIN and DERIVATIVE_GAIN when
given speed range switch is active. If two or more speed range switches will be
active simultaneously, each lowest gain value will be chosen.

Please note that these gains are not affected by MASTER_GAIN.

Switch Configuration Modes

Use the switched inputs and speed setpoint parameters to set up to four discrete
speeds and set ramp rates between speeds OR use the inputs to manually
increase or decrease speed at preset rates with variable speed control. Refer to
“Auxiliary Output Wiring” for wiring switch inputs.

Table 5-3. Switch Configuration Modes

CONFIGURATION

MODE DESCRIPTION

A single engine speed is commanded.

The engine is started and transitions from crank mode to
run mode. The commanded engine speed will be
SET_SPEED_WARMUP.

Engine speed remains at the warm up speed for
WARMUP_TIME seconds, after which the engine speed
either increases at RAMP_UP_RATE or decreases at
RAMP_DOWN_RATE to SET_SPEED_1.

= 1: SINGLE SPEED

A switch is used to select between two set speeds.

The engine is started and transitions from crank mode to
run mode. The commanded engine speed will be
=2: TWO SPEED SET_SPEED_WARMUP.

Engine speed remains at the warm up speed for
WARMUP_TIME seconds, after which the engine speed
either increases at RAMP_UP_RATE or decreases at
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CONFIGURATION

MODE DESCRIPTION

RAMP_DOWN_RATE to the speed selected by the switch
(SET_SPEED_1 or SET_SPEED_2). When the other
speed is selected with the switch, commanded engine
speed is ramped to the new set speed.

A rotary switch is used to select among three set speeds.

The engine is started and transitions from crank mode to
run mode. The commanded engine speed will be
SET_SPEED_WARMUP.

Engine speed remains at the warm up speed for

= 3: THREE SPEED WARMUP_TIME seconds, after which the engine speed
either increases at RAMP_UP_RATE or decreases at
RAMP_DOWN_RATE to the speed selected by the rotary
switch (SET_SPEED_1 to SET_SPEED_3). When another
speed is selected with the switch, the commanded engine
speed is ramped to the new set speed.

A rotary switch with two diodes is used to select among 4
set speeds.

The engine is started and transitions from crank mode to
run mode. The commanded engine speed will be
SET_SPEED_WARMUP.

Engine speed remains at the warm up speed for

=4: FOUR SPEED WARMUP_TIME seconds, after which the engine speed
either increases at RAMP_UP_RATE or decreases at
RAMP_DOWN_RATE to the speed selected by the rotary
switch (SET_SPEED_1 to SET_SPEED_4). When another
speed is selected with the switches, the commanded
engine speed is ramped to the new set speed.

A momentary switch is used to ramp desired engine speed
either up or down.

The engine is started and transitions from crank mode to
run mode. The commanded engine speed will be
SET_SPEED_WARMUP.

Engine speed remains at the warm up speed for

WARMUP_TIME seconds, after which the user may select

=5 VARIABLE a new speed by using the switches, which will either
SPEED increase or decrease engine speed.

A brief pressing of the switch will change engine speed by
one rpm. Holding the switch closed longer will ramp the
engine speed command, first at a slow rate, then at either
RAMP_UP_RATE or RAMP_DOWN_RATE, depending on
which direction the switch is being pressed. The engine
speed command will never ramp above SET_SPEED_MAX
or below SET_SPEED_MIN.

External Pot Calibration

This feature allows an external pot from a variety of applications to interface
properly with the APECS 4500. Refer to Table 5-2 for mode configurations and
descriptions.

Calibration Parameters Needing Configuration:

EXTERNAL_ANALOG_MODE
Allows the external analog input to be configured in a variety of ways.
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Calibration Procedures

The calibration procedure is automatic. Simply set the parameter
EXTERNAL_ANALOG_MODE to 255 (refer to Table 5-2) and run the external pot or
pedal up and down through its full range of travel. The controller will
automatically learn and store the minimum and range values in its memory. Set
EXTERNAL_ANALOG_MODE back to the desired speed mode when finished.

PTO Input

This feature allows selection between pedal input and speed switches in mobile
applications.

Calibration Parameters Needing Configuration:

AUXILIARY_OUTPUT_MODE
This logic value lets the software know how the auxiliary output is configured.
Set Auxiliary_Output_Mode = 3 to turn on an indicator lamp when in PTO mode.

EXTERNAL_ANALOG_MODE
This logic value lets the software know how the external analog input is
configured (see “Calibrating APECS Features”).

SWITCH_CONFIGURATION
This logic value lets the software know how the speed switch inputs are
configured.

Calibration Procedures

Select the appropriate analog input mode and configure the external analog and
switched inputs according to your application.

In the PTO “ON” mode, select the speed with speed switches. In PTO “OFF”
mode, use the pedal or the pot to adjust the speed.

As a safety feature (in drive-by-wire mode only), when the engine is initially
turned on, the mode is assumed to be PTO “OFF” regardless of the PTO switch
setting. Users have to cycle the PTO switch “OFF” and then back “ON” to enable
PTO input.

If a drive-by-wire mode is being used (003, 013, 023, 103, 113,
NO T’CE 203, 213), the engine is not allowed to start up in PTO mode.

PTO is locked out until the engine has started and the PTO
switch is transitioned from its off position.

Auto-idle mode*

Auto-idle mode is basically a potentiometer mode (no PTO) with brake input and
additional input working as auto-idle enable switch. If this switch is in the OFF
position, brake input is ignored. Auxiliary output may be configured to reflect the
auto-idle switch state.

Calibration parameters needing configuration

" This feature is present only in some APECS 4500 versions. See Table 1-1 for details.
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EXTERNAL_ANALOG_MODE
Refer to the table above for selecting correct value for auto-idle mode.

AUXILIARY_OUTPUT_MODE, AUXILIARY_OUTPUT_2_MODE
This values control the behavior of auxiliary outputs. Set to value 7 to reflect
auto-idle input state (also flashes faults when present).

BRAKE_DELAY, BRAKE_UP_RATE, BRAKE_DOWN_RATE
Refer to “Engine Set Speed Calibration Parameters” for description.

Set Speed Calibration FAQ

After a power down/power up reset, does APECS remember the last speed
it was using?

No. The only data APECS retains after power down are the calibration parameter
settings. If you are using the variable speed mode, you will have to reestablish
the desired speed after the engine is restarted.

However, if you are configured for one of the four set speed modes, then APECS
will command the same speed on the next power up, after an optional warm up
period, as long as the switches haven't been changed.

If using variable speed mode, what is the initial speed command when the
engine starts?

SET_SPEED_WARMUP. Even if WARMUP_TIME is set to 0, this will be the
initial engine speed command. It does not change until the engine is running and
the toggle switch is pressed. The toggle switch has no effect when the engine is
not running.

If using the 4-speed modes, what is the initial speed command when the
engine starts?

That depends on your use of a warm up speed. If you're using a warm up speed,
enabled by setting WARMUP_TIME to a non-zero value, then the first speed
commanded will be SET_SPEED_WARMUP. If you are not using a warm up speed,
disabled by setting WARMUP_TIME to zero, then the first speed commanded is
selected by the speed switches.

Can | command the engine to stop without powering down APECS?

Yes, if you are using 2-, 3-, or 4-speed mode. Simply set one of the set speeds to
1. When you select that speed with the switch, the engine will follow the
command to 1. Usually powering off the APECS unit shuts down the engine and
the throttle is immediately closed. However, if you command a shutdown with the
switch, and the ramp down rate is set low, the engine will be stopped in a ‘soft
shutdown’ manner.
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Speed Input Configuration Parameters

Calibration Procedures

SPEED_TYPE electrically configures the input circuitry for the speed input type
and also specifies how electrical noise is to be detected and rejected.

PULSES_PER_UPDATE and PULSES_PER_REYV are factory set to prevent the
unit from calculating an engine speed and driving the actuator.

These two parameters must be calibrated to a non-zero value before normal
APECS operation can begin.

Calibration Parameters Needing Configuration:

SPEED_TYPE

Factory set for a mag pickup. This parameter electrically configures the input
circuitry for the speed input type and also specifies how electrical noise is to be
detected and rejected. Recommended values are as follows:

e Mag Pickup: 128

Coil Ignition: 2

Magneto Ignition: 3

Hall Effect Sensor: 131

PULSES_PER_UPDATE
The number of pulses received by the controller between engine speed
calculations and updates.

The fewer the pulses, the faster the update rate and the lower the resolution; the
greater the pulses, the greater the averaging effect on calculated engine speed.
Factory set to zero. Must be non-zero to operate.

PULSES_PER_REV
The number of teeth on the engine speed pickup wheel (mag pickup input and
Hall Effect sensor), or the number of spark pulses per engine rev (ignition input).

To figure out the pulses per revolution, you must determine the kind of speed
signal input used on your application:

Magnetic Pickup Input or Hall Effect Sensor
Pulses per revolution = number of teeth on the flywheel

Woodward Mini-Gen™ Signal Generator
Pulses per revolution = 0.5 x drive ratio if Mini-Gen is driven at other than
crankshaft speed

Spark Ignition Input
Pulses per revolution = 1 for single cylinder engine with magneto and one wasted
spark

Pulses per revolution = number of cylinders / 2 for multi cylinder engine with
distributor
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PULSES_PER_REV FAQ

How does PULSES_ PER_REV work when using the ignition signal for
engine speed?

When an ignition signal is used to detect engine speed, the input pulses relate
directly to cylinder firing events rather than teeth on a flywheel. The controller
measures the time between the input pulses from the ignition. To accurately
calculate engine speed, it must know how many ignition pulses are occurring in
each engine revolution; this is PULSES_PER_REV.

The number of ignition pulses per engine revolution will vary depending on the
engine type. Factors that must be known include: how many cylinders the engine
has, whether there is a distributor, and if a waste spark is generated.

Are there any general guidelines?

Yes. Single cylinder engines typically use a magneto with a firing spark and a
wasted spark. The firing spark occurs at the end of the compression stroke, once
every 2 engine revs. The wasted spark occurs at the end of the exhaust stroke,
360° later. Therefore, the signal from the ignition will have one pulse per engine
revolution. PULSES_PER_REV = 1.

With multi-cylinder engines using a distributor, the primary ignition signal will
have one pulse for every cylinder-firing event. Since each cylinder is fired every 2
revs, PULSES_PER_REV = number of cylinders + 2.

PULSES_PER_REV must be an integer; no half pulses allowed. The ignition signal
from a 3-cylinder engine will have 3 pulses per 2 engine revs, which works out to
1.5 pulses per engine rev.

To work around this situation, assign PULSES_PER_REV = 3. Then the calculated
engine speed will be exactly half actual speed. If the engine is operating at 1800
rpm, displayed engine speed will be 900 rpm. Therefore all set speeds must be
half of the actual target speed.

If you forget and set the desired speed to 1800 rpm,
NO TICE the engine will speed up to 3600 rpm in order to reach
the target.

Engine Start Calibration Parameters
This section covers parameters for engine start calibration

Glowplug Control

On a command from an auto-start switch (using PTO input), the auxiliary output
can be configured to turn on a glowplug relay before engaging the autocrank
relay. The glowplug relay will remain on until the engine starts or until the
autocrank sequence completes the maximum permissible number of crank
cycles. This feature is useful for remote operation of certain engines or
applications.
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Calibration Parameters Needing Configuration:

AUXILIARY_OUTPUT_MODE

This parameter is used to let the software know how the auxiliary output of
APECS 4500 is to be configured. Set to a value of 6 for glowplug control. See
“Auxiliary Outputs” for settings.

AUXILIARY_OUTPUT_2_MODE

This parameter is used to let the software know how auxiliary output #2 of
APECS 4500 is to be configured. Set to a value of 6 for glowplug control. See
“Auxiliary Outputs” for settings.

GLOWPLUG_TIME
This parameter specifies the pre-heat time, in seconds, before the autocrank
relay is engaged.

GLOWPLUG_TIME_HI_TEMP”

If this parameter is written nonzero value, it will be used instead of
GLOWPLUG_TIME when speed range switch 1 will be active (see “Switched
Analog Speed Ranges And Governor Gains”). If it is written zero (which is
default), GLOWPLUG_TIME will be used regardless of speed range switch 1.
Calibration Procedures

The glowplug feature is enabled by setting AUXILIARY_OUTPUT_MODE or
AUXILIARY_OUTPUT_2_MODE to 6.

When the auto-start switch is made, the glowplug output becomes active for
GLOWPLUG_TIME (sec) before the autocrank relay is engaged.
Autocrank

On a command from an auto-start switch (using PTO input), an engine will go
through an autocrank sequence (using auxiliary output). This feature is useful for
remote operation of certain engines or applications.

To effectively use the autocrank feature, the actuator
No TICE should be able to stop the engine, otherwise an
ignition cutoff type system must be provided.

Calibration Parameters Needing Configuration:

AUTOCRANK_CRANK_TIME

Specifies the maximum time, in seconds that the engine will crank. If the engine
starts during the crank period, engine cranking will be terminated. Range: 0-31.9
seconds.

AUTOCRANK_MAX_TRIES
Maximum number of crank/rest cycles before autocrank logic stops trying to start
the engine and flags a fault. Range: 0-255.

AUTOCRANK_REST_TIME

If the engine does not start during the cranking interval, cranking will be disabled
for AUTOCRANK_REST_TIME seconds in order to permit the starter motor to cool.
Range: 0-31.9 seconds.

" This parameter is present only is some APECS 4500 versions. See Table 1-1 for details.
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AUXILIARY_OUTPUT_MODE
This parameter is used to let the software know how the auxiliary output of
APECS 4500 is to be configured. See “Auxiliary Outputs” for settings.

AUXILIARY_OUTPUT_2_MODE
This parameter is used to let the software know how auxiliary output #2 of
APECS 4500 is to be configured. See “Auxiliary Outputs” for settings.

Calibration Procedures

The autocrank feature is enabled by setting AUXILIARY_OUTPUT_MODE or
AUXILIARY_OUTPUT_2_ MODE to 4. PTO is not available with autocrank.

When the auto-start switch is made, the autocrank output waits
GLOWPLUG_TIME seconds then becomes active for
AUTOCRANK_CRANK_TIME (sec) or until the engine starts. If the engine does
not start, then the output goes inactive for AUTOCRANK_REST_TIME (sec), and
then another crank attempt is made. The sequence is repeated for
AUTOCRANK_MAX_TRIES. If the engine has not started after the maximum
crank attempts have been made, a fault is flagged.

When the auto-start switch is turned off, actuator duty cycle is set to zero to shut
down the engine.

Engine Cranking

The engine cranking parameters control how APECS will drive the actuator
during cranking.

Calibration Parameters Needing Configuration:

CRANK_2_RUN

Speed transition point indicating engine has gone from crank mode to run mode
(rpm). Once engine rpm rises above CRANK_2_RUN rpm, it is assumed that the
engine is in run mode.

CRANK_DUTY_CYCLE
The fixed duty cycle used to drive the actuator when the engine is cranking
(percent).

May be calibrated to a maximum duty cycle for diesel engines that require full
rack for starting, or a minimum duty cycle for some spark-ignition engines that
require closed throttle for starting.

This parameter is preset to a value that will work with
IMPORTANT most engines and applications. Entering new values for
these parameters is optional.

KEY_ON_DUTY_TIME

The actuator will be driven at CRANK_DUTY_CYCLE following key-on reset for
KEY_ON_DUTY_TIME (in seconds) while there is no input speed signal. Once a
valid speed signal is detected, normal operation ensues. This is useful for
applications that do not generate a speed input signal at crank (e.g. genset which
senses engine speed from the generator output). When using this feature, the
duty cycle does not cut back until a valid input speed signal is seen, or the
timeout period is up. If there is never a valid input speed, the actuator will
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continue to be driven at CRANK_DUTY_CYCLE even if the engine is running. This
could lead to an overspeed situation. Default value: 0

Calibration Procedures

CRANK_DUTY_CYCLE may be calibrated to a maximum duty cycle for diesel
engines that require full rack for starting, or a mid-range duty cycle for some
spark-ignition engines that require a partially open throttle for starting.

In run mode, control is closed-loop; the actuator is driven as necessary to
maintain the set desired speed.

Setting KEY_ON_DUTY_TIME (seconds) to a non-zero value will cause the
actuator to be driven to the crank duty cycle, even if no engine speed signal is
present. The actuator is energized at key-on reset for the set amount of time.
This may be useful for generator applications where it is desirable to sense
engine speed from the generator frequency.

To keep speed voltage below 75 Vrms, a step down transformer may be
necessary. When this feature is used, it is especially important to have a
redundant overspeed protection device because a broken speed input wire could
cause the engine to run at wide open throttle for up to KEY_ON_DUTY_TIME.

Diagnostics Calibration Parameters

This section covers diagnostic calibration parameter configuration.

Engine Protection Input

User selectable input to protect against adverse conditions such as high coolant
temperature or low oil pressure. In case of oil pressure, allows the engine time
for oil pressure to rise following startup.

Calibration Parameters Needing Configuration:

ENGINE_PRTCT_RUN_TIME
The time, in seconds, that the engine must be running before the engine
protection logic begins to monitor the engine protection input.

This permits the APECS 4500 to automatically account for oil pressure switches
and similar devices that indicate a fault condition when the engine is not running.
Setting ENGINE_PRTCT_RUN_TIME to 8000 or more will disable the engine
protection option.

ENGINE_PROTECT_TIME
The amount of time spent with the engine protection input made before the
actuator is shut down (ms).

The APECS 4500 has a dedicated engine protection switch input. The engine
protection feature must be enabled by setting ENGINE_PRTCT_RUN_TIME to a
value less than 8000. Once the engine has been in run mode longer than
ENGINE_PRTCT_RUN_TIME, if the engine protection input is grounded for
longer than ENGINE_PROTECT_TIME milliseconds, the governor will go into
shutdown mode and the fault lamp will flash a four code.

Calibration Procedures
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ENGINE_PRTCT_RUN_TIME is set to the time in seconds the engine must be
running before a grounded signal on the engine protection input will be serviced.
If ENGINE_PRTCT_RUN_TIME is set to 0, then the input will also inhibit any
actuator duty cycle at cranking if the engine protection switch contacts are
closed. The input must be made before engine shutdown (actuator output) will
begin.

If the engine has been running longer than ENGINE_PRTCT_RUN_TIME, and
the engine protection input has been made continually (not intermittently), then
the actuator will be shutdown and a fault will be generated. The lamp on the
APECS unit will flash to indicate the fault, and the fault will be cleared when the
engine is restarted.

Overspeed / Underspeed Protection

This feature incorporates user selectable overspeed and underspeed parameters
that affect engine shutdown.

Calibration Parameters Needing Configuration:

OVERSPEED_RPM
Critical engine speed used for overspeed protection (rpm).

Set OVERSPEED_RPM to zero if overspeed protection is not desired. Normal
closed-loop governing will decrease the duty cycle to the actuator any time
engine speed is above the set point. Overspeed protection shuts off the actuator
when an overspeed condition is detected for the time longer than set in
OVERSPEED_TIME parameter. Engine speed must be brought back to zero for
at least two seconds before the actuator is driven again. Setting
OVERSPEED_RPM to zero disables the overspeed protection feature. Default
value: 0.

UNDERSPEED_RPM
Minimum engine speed used for underspeed shutdown (rpm).

Normal closed-loop governing will increase the duty cycle to the actuator any
time engine speed is below the set point. Underspeed shutdown shuts off the
actuator when an underspeed condition is detected for the time longer than set in
UNDERSPEED_TIME parameter. Engine speed must be brought back to zero
before the actuator is driven again. Setting UNDERSPEED_RPM to zero
disables the underspeed protection feature.

UNDERSPEED_RUN_TIME
Amount of time the engine must be in run mode before underspeed shut down is
activated (seconds).

Calibration Procedures

The overspeed protection feature immediately shuts off the actuator when the
engine runs above OVERSPEED_RPM. Setting the OVERSPEED_RPM value to
zero disables this feature.

The underspeed protection feature immediately shuts off the actuator when the
engine rpm runs under the UNDERSPEED_RPM value. Set the
UNDERSPEED_RUN_TIME value as desired. Setting the UNDERSPEED _RPM
value to zero disables the underspeed protection feature.
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When an engine overspeed/underspeed condition is detected, the engine
protection control logic causes: (1) the actuator duty cycle to go immediately to
zero (2) a fault code activation which is signified by LED flashing. After engine
protection control logic tripping, the fault code will continue to flash the LED. This
signifies to the user that the engine stopped due to overspeed or underspeed
engine conditions. The engine may later be restarted without resetting the unit;
this action will cause the fault code to reset and the LED will then stop flashing.

Overspeed FAQ
How Does Overspeed Work?

The APECS 4500 has the diagnostic capability to detect and react to an
overspeed condition. The feature uses two programmable parameters,
OVERSPEED_RPM and OVERSPEED_TIME. Overspeed feature immediately shuts
off the actuator when the engine runs above OVERSPEED_RPM for
OVERSPEED_TIME.

OVERSPEED_TIME is used to adjust the sensitivity. A large value will delay the
shut down, and a small value will hasten it. A value as small as zero can be
used, which means that the first occurrence of engine speed being over
OVERSPEED_RPM will result in a shut down. This is too sensitive and the engine
could be shut down in the unlikely event that noise on the speed signal input
caused a high miscalculation of engine speed. A minimum value of 250 ms is
recommended. The user should realistically determine an overspeed tolerance
time.

When an overspeed condition is detected, the duty cycle goes immediately to
zero. This should stop the engine or at least drive it to minimum speed. A fault
code is generated, and the LED flashes. The fault will continue to flash so that
the user is made aware of why the engine stopped. The engine may be restarted
without resetting the unit. The fault will then recover and stop flashing.

By default, overspeed is disabled. This is because a properly tuned PID governor
will decrease the duty cycle to the actuator any time engine speed is above the
set point. So ordinarily, overspeed is not necessary. It is disabled by setting
OVERSPEED_RPM to zero. However, if a user feels the need for a more
aggressive response to an overspeed condition, the overspeed diagnostic
feature may be used.

Actuator Output Calibration Parameters

This section covers actuator output calibration parameter configuration.

Actuator Current Protection

The actuator current protection feature limits current to the actuator in order to
protect the actuator from overheating. Current protection limits the steady-state
current to the actuator, but allows higher currents for short durations. There are
three types of current limiting:

1. Soft limit (can be exceeded for a brief period of time).

2. Hard limit (can never be exceeded)—provides short-circuit protection for the
driver.

3. Battery voltage drop monitoring — provides additional short circuit protection
by observing battery voltage drop after enabling current to actuator.

74 Woodward



Manual 36752D APECS 4500 Electronic Engine Speed Governing System

SOFT LIMIT

Actuator current is monitored using display parameter actuator_fdbk_sense. If
actuator_fdbk_sense exceeds HIGH_ACTFDBK_LMX for HIGH_ACTFDBK_TIME (in
seconds), then the duty cycle maximum limit is ramped down until the current is
below the limit threshold.

Once the current sense is under the threshold, the recovery period,
HIGH_AFB_RECV_TIME (in seconds), maintains the reduced duty cycle limit. After
the recovery period, the duty cycle limit is allowed to ramp back up to its normal
level. As the duty cycle is ramping back up, and if it exceeds the upper limit, it is
immediately ramped back down again. Once the duty cycle limit ramps up
completely, current protection is fully recovered.

High current limiting is only active in run mode. There is no limit (except for short
circuit protection) during cranking. It is assumed that the crank sequence will not
be long enough to damage an actuator.

HARD LIMIT

There is also a higher critical threshold, HIGH_AFB_CRITICAL, intended to protect
the controller from a short circuit on the actuator output. If actuator_fdbk sense
exceeds this critical threshold, then the duty cycle is immediately reduced to
zero. Recovery is allowed after HIGH_AFB_RECV_TIME (in seconds). With zero
duty cycle, it is unlikely that an engine will start or run. Critical current protection
is active in all engine operating modes.

While current is being actively limited, fault 9 is flagged—Ilimiting excessive
actuator current. If the fault is due to exceeding HIGH_AFB_CRITICAL, which
causes the duty cycle to go to zero and the engine to not start or shut down, the
fault will remain active until the engine is restarted. This helps the user to
determine the cause of an engine shutdown.

Actuator current is proportional to the current driver feedback sense output. Due
to sensitivity to voltage at low current levels, the feedback sense value is not
converted to amps, which might be regarded as inaccurate. The feedback sense
value is accurate in relative terms, and is adjusted for part-to-part variability.

The current sense output from the driver chip is read by the a/d converter, and
stored in variable adc_actfb. This value is then filtered using a first-order filter
with time constant ACT_FDBK_KFILT. The resulting filtered value is adc_actfb_filt.
To account for part-to-part variability, adc_actfb_filt is then multiplied by gain
ACTUATOR _FDBK_GAIN, yielding actuator_fdbk_sense.

BATTERY VOLTAGE DROP MONITORING

This functionality measures the battery voltage in two states:

* when actuator output is enabled — vbat_on,

¢ when actuator output is disabled — vbat_off,

and calculates the ratio of these values — vbat_drop_filt. Because of battery
wires’ resistance, battery voltage drops slightly after actuator output is enabled in
normal operation. Therefore vbat_drop_filt is a number between 0 to 100%. If
actuator output is shorted (e.g. because of wire break or actuator damage),
current drain is much higher, resulting in significantly bigger drop of vbat_on and
lower values of vbat_drop_filt.

If voltage drop lower than VBAT_DROP_FAULT is detected, actuator overcurrent
fault (flash code 9) is activated. Dutycycle is immediately reduced to zero. This
protection is active in all engine operating modes.
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Calibration Parameters Needing Configuration:

HIGH_ACTFDBK_DC_RAMP
This current protection feature limits the steady-state current to the actuator, but
allows higher currents for short durations.

If actuator_fdbk_sense exceeds HIGH_ACTFDBK_LMX then the duty cycle
maximum limit is ramped down until the current is below the limit threshold. After
the recovery period (HIGH_AFB_RECV_TIME) the duty cycle limit is allowed to
ramp back up to its normal level. Once the duty cycle limit ramps up completely,
current protection is fully recovered.

HIGH_ACTFDBK_DC_RAMP controls the rate at which the duty cycle is ramped
up and down, specified in units of duty cycle change per 10 msec. For example,
if the value is 0.01, it means that the duty cycle will change by 1% every 10 ms,
or 100% in 1 sec.

HIGH_ACTFDBK_LMX
This current protection feature limits the steady-state current to the actuator, but
allows higher currents for short durations.

If actuator_fdbk_sense exceeds HIGH_ACTFDBK_LMX for
HIGH_ACTFDBK_TIME then the duty cycle maximum limit is ramped down until
the current is below the limit threshold. After the recovery period
(HIGH_AFB_RECV_TIME) the duty cycle limit is allowed to ramp back up to its
normal level. Once the duty cycle limit ramps up completely, current protection is
fully recovered.

The lamp on the APECS controller flashes (flash code 9) to indicate controller is
limiting excessive actuator current.

Current protection limits are NOT active during cranking. It is
IMPORTANT assumed that the crank sequence will not be long enough to damage

an actuator.

HIGH_ACTFDBK_TIME
This current protection feature limits the steady-state current to the actuator, but
allows higher currents for short durations.

If actuator_fdbk sense exceeds HIGH_ACTFDBK_LMX for HIGH_ACTFDBK_TIME
(in seconds) then the duty cycle maximum limit is ramped down until the current
is below the limit threshold. After the recovery period (HIGH_AFB_RECV_TIME) the
duty cycle limit is allowed to ramp back up to its normal level. Once the duty
cycle limit ramps up completely, current protection is fully recovered.

The lamp on the APECS controller flashes (flash code 9) to indicate controller is
limiting excessive actuator current.

Current protection limits are NOT active during cranking. It is
IMPORTANT assumed that the crank sequence will not be long enough to damage

an actuator.

HIGH_AFB_CRITICAL

If actuator_fdbk _sense exceeds HIGH_AFB_CRITICAL, the actuator duty cycle is
immediately reduced to zero. Recovery is allowed after HIGH_AFB_RECV_TIME
seconds. With zero duty cycle, it is unlikely that an engine will start or continue to
run. Critical current protection is active in all engine operating modes.
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The lamp on the APECS controller flashes (flash code 9) to indicate controller is
limiting excessive actuator current.

HIGH_AFB_RECV_TIME

If actuator_fdbk sense exceeds HIGH_ACTFDBK_LMX for HIGH_ACTFDBK_TIME
(in seconds) then the duty cycle maximum limit is ramped down until the current
is below the limit threshold. After the recovery period (HIGH_AFB_RECV_TIME) the
duty cycle limit is allowed to ramp back up to its normal level. Once the duty
cycle limit ramps up completely, current protection is fully recovered.

The lamp on the APECS controller flashes (flash code 9) to indicate controller is
limiting excessive actuator current.

Current protection limits are NOT active during cranking. It is
IMPORTANT assumed that the crank sequence will not be long enough to damage

an actuator.

VBAT_DROP_FAULT

If battery voltage drop ratio (see “BATTERY VOLTAGE DROP MONITORING”
above) falls below this value, actuator dutycycle is immediately reduced to zero.
The lamp on APECS controller will flash code 9 to indicate controller is limiting
actuator current.

For most systems it is recommended to leave this parameter at default value. If
battery voltage drop (monitoring variable — vbat_drop_filt) during normal
operation drops below VBAT_DROP_FAULT, it may be considered to decrease
VBAT_DROP_FAULT value to prevent false detection. Setting this parameter to
zero disables actuator overcurrent protection by battery voltage drop monitoring.

Calibration Procedures

Because actuator_fdbk_sense is dependent upon both supply voltage and
actuator type, it may be necessary to determine the exact scaling between
current and the parameter actuator_fdbk sense. As a rough approximation:
actuator_fdbk_sense = 80 x actuator current (amps).

The user can determine the exact relationship between current and
actuator_fdbk_sense by placing an ammeter in series with the actuator and
recording both current and actuator_fdbk_sense during cranking when duty cycle
is fixed. Once the exact scaling is determined and the desired current limits are
known, the actual current limits can be calculated.

For most applications, the default value for the hard limit will suffice to protect the
controller. If desired, HIGH_AFB_CRITICAL may be decreased. Increasing this
parameter may jeopardize the control module and is not recommended.

The values for the soft limits may be adjusted to limit current and may be
dependent on the actuator type. In general, smaller actuators will need lower
limits, as will 24-volt coils. The limits may be dependent upon ambient
temperature—the higher the ambient temperature, the lower the limit will be
since the actuator can dissipate less current. Current threshold
(HIGH_ACTFDBK_LMX), time at current (HIGH_ACTFDBK_TIME), ramp rate
(HIGH_ACTFDBK_DC_RAMP), and recovery time (HIGH_AFB_RECV_TIME) may all
be adjusted at the discretion of the operator.

Battery voltage drop should be tested (monitoring variable — vbat_drop_filt).
Battery voltage drop value in normal operation depends mostly on power supply
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wires’ resistance and current drain of an actuator. The biggest drop value will be
observed for highest dutycycle values (for example during cranking). If battery
voltage drop during normal operation falls below VBAT_DROP_FAULT value,
this will result in actuator overcurrent (flash code 9) being detected. In this
situation, value of VBAT_DROP_FAULT should be decreased to get the safe
margin for operation.

Auxiliary Outputs

The two auxiliary outputs are multipurpose outputs that can drive a lamp or a
relay. See the sections beginning on page 16 for wiring information.

Calibration Parameters Needing Configuration:

AUX_OUTPUT_RPM

When AUXILIARY_OUTPUT_MODE = 1, APECS 4500 turns on the auxiliary output
when engine rpm exceeds this speed. The auxiliary output turns back off if
engine speed falls 20 rpm below AUX_OUTPUT_RPM.

AUX_OUTPUT_2_RPM

When AUXILIARY_OUTPUT_2_MODE = 1, APECS 4500 turns on auxiliary output
#2 when engine rpm exceeds this speed. The auxiliary output turns back off if
engine speed falls 20 rpm below AUX_OUTPUT_2_RPM.

AUXILIARY_OUTPUT_MODE
This parameter is used to let the software know how the auxiliary output of
APECS 4500 is to be configured.

AUXILIARY_OUTPUT_2_MODE
This parameter is used to let the software know how auxiliary output #2 of
APECS 4500 is to be configured.

Calibration Procedures
Set the AUXILIARY_OUTPUT_MODE and AUXILIARY_OUTPUT_2_ MODE values

to the settings below to achieve a target configuration for a certain APECS
4500/engine system setup.

VALUE AUXILIARY OUTPUT RESULT

0 No output

1 ON when engine speed is above AUX_OUTPUT_RPM

2 OFF when there is an active diagnostic shutdown condition;
use with auxiliary shutdown device

3 ON when PTO is engaged; use with PTO indicator lamp

4 Autocrank output, use to drive engine crank motor relay

5 Mimics on-board LED (ON when engine speed present,
flashes faults)

6 Glowplug control

7 Auto idle lamp
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Droop Governing

When governor droop is non-zero, governed speed reduces with increasing load.
Droop may be desirable in certain load sharing applications (e.g., two gensets
tied to the same electrical bus). When droop is set to zero, governed speed will
be insensitive to load (isochronous).

Calibration Parameters Needing Configuration:
DROOP_ACTFDBK_MAX

Value of actuator_fdbk_sense when operating at maximum engine load. Used in
conjunction with the droop governing feature.

DROOP_ACTFDBK_MIN
Value of actuator_fdbk sense when operating at no engine load. Used in
conjunction with the droop governing feature.

DROOP_PERCENT
Desired engine droop. Range: 0-15%. Droop is calculated as follows:

Droop=(actuator_fdbk_sense—DROOP_ACTFDBK_MIN) / (DROOP_ACTFDBK_MAX—
DROOP_ACTFDBK_MIN)

Calibration Procedures

When operating in droop governing mode, the engine speed decreases (droops)
as the load is increased.

Monitor actuator feedback at no load and at full load and set
DROOP_ACTFDBK_MIN and DROOP_ACTFDBK_MAX to these values respectively.
Set DROOP_PERCENT to desired droop up to 15%.

Load is inferred by measuring the actuator sense current output of the current
driver.

Set DROOP_PERCENT to zero for isochronous governing.

Woodward 79



APECS 4500 Electronic Engine Speed Governing System Manual 36752D

Calibration Setup & Configuration Parameters Flowchart

Step 1 Step 2
Setup the APECS Calibration Tool

" | configure speed input
(ACT) gure speed inp
—
=
Inberfoce Modue
APECS 4000 Cortroler _\\_
O G
Y
@ =i d Speed Input Configuration
T PULSES_PER_REV
_APECS' = Cornecter Cable PULSES_PER_UPDATE
— =-r Tht_ese two parameters must be
= o calibrated to a non-zero value before
noraml APECS operation can begin
O 2

The APECS 4000 is a user configurable engine speed governor and will follow your
settings and commands immediately. It is possible to enter values in the APECS
module that are in excess of what the engine is capable of performing and outside of
safe operating range. It is the user's resposibility to pay attention when entering data
into the APECS or the ACT. Entering values outside of safe operating range can
result in serious physical injury and/or damage to the equipment or application.
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Step 3 Step 4
» Calibrate the selected features by Determine how you would like to
configuring the listed parameters configure the speed set-point logic
Engine Cranking Default No external analog input Speed Momentary
CRANK_DUTY_CYCLE .95 Use speed switch to select up to four Switch Switch
CRANK_2_RUN 750 RPM discreet speeds or use momentary o
KEY_ON_DUTY_TIME 0 switch to increase or decrease speed R
at preset rates | >

Engine Protection Input

ENGINE_PROTECT_RUN_TIME Trim Mode Speed ) -
default = 8000 (disabled) Use external pot or voltage Switch im:Ret
input to trim the selected set AND
speed @ >
Overspeed/Underspeed
Protection Al dlsabdlzgagl); Set Speed with pot 5 4 Fat
i >
OVERSPEED_RPM Use external pot to adjust set speed. ket 2
UNDERSPEED_RPM PTO is available.
UNDERSPEED_RUN_TIME
>
Actuator Current Protection
OVER_CURRENT_LMX
Speed Pot < ﬁ »
OFF k= ON L
Auxiliary Output Default) PTO
AUXILIARY_OUTPUT_MODE 0 T >
AUXILIARY_OUTPUT_RPM 0
Drive-by-wire Pedal
Droop Governing Default Similar to set speed with pot but with
additional fault management. Suitable >
DROOP_CURRENT_MAX 0 for pedal applications.
DROOP_CURRENT_MIN 0
DROOP_PERCENT 0 PTO is availlable
Idle verification switch is availlable
Pedal 7 R
>
OFF & ON
PTO Input .
PTO
EXTERNAL_ANALOG_MODE >
SWITCH_CONFIGURATION
CAN Input
Uses value provided by VCU >
(Vehicle Control Unit) by CAN
interface
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Step 5

Select appropriate external analog
mode

Use speed switch (EXTERNAL_ANALOG_MODE = 000)

Step 6

Calibrate the required parameters
to configure engine speed input

SET_SPEED 1-4
>

Use momentary switch (EXTERNAL_ANALOG_MODE = 000)

SWITCH_CONFIGURATION 1-4

Trim Mode (EXTERNAL_ANALOG_MODE = 001)

SWITCH_CONFIGURATION =5

SET_SPEED_MIN L e
SET_SPEED_MAX

Trim Mode, reverse pot (EXTERNAL ANALOG MODE = 101)

Set speed with pot EXTERNAL_ANALOG_MODE = 002)

SWITCH_CONFIGURATION 1-4
SET_SPEED 1-4

SET_SPEED_TRIM >
SET_SPEED_MIN
SET_SPEED_MAX

Set speed with reverse pot (EXTERNAL ANALOG MODE = 102)

DTL SPSTU Wit PUL LA T LININVAL_ AINALUY WIvDL = ausy

Set speed with pot, PTO Available EXTERNAL_ANALOG_MODE = 012)

SET_SPEED_MIN
SET_SPEED_MAX ——

SWITCH_CONFIGURATION 1-4
SET_SPEED 1-4

Set speed with reverse pot (EXTERNAL ANALOG MODE = 112) SET SPEED MIN >

—= — - P SET_SPEED_MAX

Drive-by-wire, no IVS (EXTERNAL_ANALOG_MODE =003)

Drive-by-wire, IVS normally closed (EXTERNAL_ANALOG_MODE =103) §E$—gzggg—m2§ L—

Drive-by-wire, IVS normally open (EXTERNAL_ANALOG_MODE - -

=203)

Drive-by-wire, no IVS (EXTERNAL_ANALOG_MODE =013)

. . g SWITCH_CONFIGURATION 1-4

Drive-by-wire, IVS normally closed (EXTERNAL_ANALOG_MODE =113) o SET SPEED 1-4

Drive-by-wire, IVS normally open (EXTERNAL_ANALOG_MODE SET:SPEEDiMIN >

=213) _ | SET_SPEED_MAX

CAN Input (EXTERNAL_ANALOG_MODE =40) .
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Step 7

Calibrate any additional
parameters , if needed.

| RAMP_DOWN_RATE

> RAMP_UP_RATE
| SPEED_DECREASE DELAY

| the parameter EXTERNAL_ANALOG_MODE to

SET_SPEED_WARMUP
WARMUP_TIME

External Pot Calibration

The external pot calibration needs to be
calibrated for use in the desired speed mode.
The calibration process is automatic. Simply set

255 and run the external pot or pedal through its
full range of travel. The controller will

automatically learn and store the minimum and
range values in its memory. Set

EXTERNAL_ANALOG_MODE back to the
desired speed mode when finished.

\ 4

SET_SPEED_WARMUP
WARMUP_TIME
RAMP_DOWN_RATE
RAMP_UP_RATE
SPEED_DECREASE_DELAY
(PTO only)

Step 8

Calibrate any additional
parameters , if needed.

e

!

™

PID Gains too high

PID Gains too low

PID Gains Adjustment
DERIVATIVE_GAIN
INTEGRAL_GAIN
PROPORTIONAL_GAIN
MASTER_GAIN

Dvsres o
N

P—
™
Integral gain too high

or derivative gain too
low

o
™

[

Derivative gain too
high

Integral gain too low

Desired response
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Chapter 6.

Troubleshooting

General Checklist

Please follow the checklist below to troubleshoot your APECS controller.

We recommend using a digital multimeter capable of measuring frequency and
duty cycle such as a Fluke 87.

1. Check battery voltage for stability and correct value. The LED will turn on for
one second when the APECS 4500 is first powered up.

2. For magnetic pickups, check that the speed signal is at least 2 Vs using the
AC volt settings on voltmeter. Actuator should go to full travel during
cranking. The LED will illuminate when it senses an engine speed.

3. Check the actuator linkage for binding and backlash.

4. Check that the actuator has sufficient force to reach the starting and rated
load positions.

5. Confirm normal operation of engine under manual control.

6. Confirm that the load (e.g., voltage regulator on generator) is not inducing
instability.

7. Try adjusting the gains to achieve stability.

Fault Codes

The APECS 4500 controller is capable of identifying certain fault conditions and
alerting the user to them. A flashing LED indicates the fault conditions. The
current fault code list is shown in Table 6. Please note the following:

1. When power is first applied to the controller, the LED will flash just once for
one second to indicate that the LED is working.

2. If there are multiple faults, the LED will flash them all in sequence. Count the
flash codes to determine the fault conditions or connect the Calibration Tool
to observe the fault conditions. (Use the “Display Faults” option under the
Monitor Menu.)

3. If there are no faults, the LED will flash once at reset and from then on
indicate the detection of engine speed. A continuous ON LED indicates that a
valid engine speed is being sensed.

4. The controller will attempt to shut down for some faults and will not permit
starting after reset with faults 1, 5 and 8.
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Table 6-1. Fault Codes

FLASH ENGINE
CODE FAULT SHUTDOWN CORRECTIVE ACTION
1 AP.ECS unit not Yes Calibrate APECS unit.
calibrated
Check parameter settings. Overspeed criteria may
be too sensitive.
Endine speed Check for electrical noise entering controller.
2 gine sp Yes Check wiring and connections.
excessive
Check case ground.
Make sure linkage moves freely, without backlash.
Check tip of speed sensor.
Enaine speed Check parameter settings.
3 9 P Yes Check linkage and the actuator travel.
unusually low ) . .
Ensure that load is not greater than engine capacity.
Engine shqtdown Check parameter settings.
4 due to engine Yes . L
9 Check what may have triggered the protection input.
protection input
If calibration file is available, download calibration file
5 Factory settings Yes and cycle power again.
lost If controller still does not work or if no calibration file
is available, consult factory.
External pot Verify that pot is wired correctly.
6 No .
out-of-range Recalibrate external pot.
Accelerator
7 position / idle No Verify that signals are working and synchronized.
switch conflict
Electrical noise may be entering controller.
. Check wiring, shielding and connections to
Controller unit
8 - Yes controller.
failed .
Cycle power to engine.
If controller still does not work, consult factory.
Check actuator for short to ground or low resistance.
Ensure that battery voltage drop isn’t too high (e.qg.
due to weak battery or excessive power supply
Limiting wires’ resistance).
9 excessive No Ensure that loads other than actuator are not
actuator current causing excessive battery voltage drop.
Check parameter settings.
Check linkage and actuator travel.
Ensure that load is not greater than engine capacity.
Engine speed (Active only in Autocrank mode)
10 input signal No Check speed sensor wiring.
missing Check starter motor.
11 Autocrank L_Jnable No Check fuel.
to start engine
Auxiliary output Check the lamp or relay hooked to the output. If fault
12 . No e
is shorted is still present, consult factory.
Auxiliary output Check the lamp or relay hooked to the output. If fault
13 : No S
#2 is shorted is still present, consult factory.
A_ctuator Check actuator wiring and actuator resistance.
14 disconnected or No )
L Resistance should be less than 10 ohms.
open circuit

Woodward

85




APECS 4500 Electronic Engine Speed Governing System Manual 36752D

Glossary of Technical Terms

ACT (All-purpose Calibration Tool) Software
PC software program for configuring and calibrating the APECS controller

Actuator
Device that converts an electrical signal from the APECS controller to an output
shaft position

APECS (Advanced Proportional Engine Control System)
Engine governing system developed by Woodward

APP
Analog Pedal Position. An analog input with voltage proportional to the desired
engine speed

Autocrank
An APECS feature that allows remote or automatic starting of the engine using
one of the auxiliary outputs

Cal File
File containing APECS calibration data

Cal Tool Version
The version of calibration tool software in use

Calibration
Process of configuring and adjusting the controller to work with a specific
application

Calibration Wizard
Interactive software guide to help you set up basic calibration and get the
controller in operation quickly

Control Strategy
The version of software residing in the controller

Duty Cycle
Percentage of time a pulse width modulated (PWM) signal remains on

Glowplugs
Electric heating elements used to enhance cold starting of diesel engines. The
auxiliary outputs can be configured to control glowplugs through a relay

Parameter
Numerical value that helps the user calibrate the APECS controller

PTO
Power Take-off. An APECS feature that allows selection between pedal input
and speed switch

PWM (Pulse Width Modulation)

Means of simulating analog output with a digital device. The PWM duty cycle
determines the equivalent analog output: the higher the duty cycle, the higher the
equivalent analog output.

Speed Sensor
Device such as a magnetic pickup that senses engine speed
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Chapter 7.

Service Oetions

Product Support Options

If you are experiencing problems with the installation, or unsatisfactory

performance of a Woodward product, the following options are available:

1. Consult the troubleshooting guide in the manual.

2. Contact the OE Manufacturer or Packager of your system.

3. Contact the Woodward Business Partner serving your area.

4. Contact Woodward technical assistance via email
(EngineHelpDesk@Woodward.com) with detailed information on the
product, application, and symptoms. Your email will be forwarded to an
appropriate expert on the product and application to respond by telephone
or return email.

5. If the issue cannot be resolved, you can select a further course of action to
pursue based on the available services listed in this chapter.

OEM or Packager Support: Many Woodward controls and control devices are
installed into the equipment system and programmed by an Original Equipment
Manufacturer (OEM) or Equipment Packager at their factory. In some cases, the
programming is password-protected by the OEM or packager, and they are the best
source for product service and support. Warranty service for Woodward products
shipped with an equipment system should also be handled through the OEM or
Packager. Please review your equipment system documentation for details.

Woodward Business Partner Support: Woodward works with and supports a
global network of independent business partners whose mission is to serve the
users of Woodward controls, as described here:

e A Full-Service Distributor has the primary responsibility for sales, service,
system integration solutions, technical desk support, and aftermarket
marketing of standard Woodward products within a specific geographic area
and market segment.

e An Authorized Independent Service Facility (AISF) provides authorized
service that includes repairs, repair parts, and warranty service on
Woodward's behalf. Service (not new unit sales) is an AISF's primary
mission.

e A Recognized Engine Retrofitter (RER) is an independent company that
does retrofits and upgrades on reciprocating gas engines and dual-fuel
conversions, and can provide the full line of Woodward systems and
components for the retrofits and overhauls, emission compliance upgrades,
long term service contracts, emergency repairs, etc.

A current list of Woodward Business Partners is available at
www.woodward.com/directory.

Product Service Options

Depending on the type of product, the following options for servicing Woodward
products may be available through your local Full-Service Distributor or the OEM
or Packager of the equipment system.

¢ Replacement/Exchange (24-hour service)

e Flat Rate Repair

e Flat Rate Remanufacture
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Replacement/Exchange: Replacement/Exchange is a premium program
designed for the user who is in need of immediate service. It allows you to
request and receive a like-new replacement unit in minimum time (usually within
24 hours of the request), providing a suitable unit is available at the time of the
request, thereby minimizing costly downtime.

This option allows you to call your Full-Service Distributor in the event of an
unexpected outage, or in advance of a scheduled outage, to request a
replacement control unit. If the unit is available at the time of the call, it can
usually be shipped out within 24 hours. You replace your field control unit with
the like-new replacement and return the field unit to the Full-Service Distributor.

Flat Rate Repair: Flat Rate Repair is available for many of the standard
mechanical products and some of the electronic products in the field. This
program offers you repair service for your products with the advantage of
knowing in advance what the cost will be.

Flat Rate Remanufacture: Flat Rate Remanufacture is very similar to the Flat
Rate Repair option, with the exception that the unit will be returned to you in “like-
new” condition. This option is applicable to mechanical products only.

Returning Equipment for Repair

If a control (or any part of an electronic control) is to be returned for repair,
please contact your Full-Service Distributor in advance to obtain Return
Authorization and shipping instructions.

When shipping the item(s), attach a tag with the following information:
return number;

name and location where the control is installed;

name and phone number of contact person;

complete Woodward part number(s) and serial number(s);
description of the problem;

instructions describing the desired type of repair.

Packing a Control

Use the following materials when returning a complete control:

e  protective caps on any connectors;

e  antistatic protective bags on all electronic modules;

e  packing materials that will not damage the surface of the unit;

e atleast 100 mm (4 inches) of tightly packed, industry-approved packing
material;

a packing carton with double walls;

e astrong tape around the outside of the carton for increased strength.

To prevent damage to electronic components caused by improper

NO TICE handling, read and observe the precautions in Woodward manual
82715, Guide for Handling and Protection of Electronic Controls,
Printed Circuit Boards, and Modules.

Replacement Parts

When ordering replacement parts for controls, include the following information:
e the part number(s) (XXXX-XXXX) that is on the enclosure nameplate;
e the unit serial number, which is also on the nameplate.
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Engineering Services

Woodward’s Full-Service Distributors offer various Engineering Services for our
products. For these services, you can contact the Distributor by telephone or by
email.

e  Technical Support

e  Product Training

e Field Service

Technical Support is available from your equipment system supplier, your local
Full-Service Distributor, or from many of Woodward’s worldwide locations,
depending upon the product and application. This service can assist you with
technical questions or problem solving during the normal business hours of the
Woodward location you contact.

Product Training is available as standard classes at many Distributor locations.
Customized classes are also available, which can be tailored to your needs and
held at one of our Distributor locations or at your site. This training, conducted by
experienced personnel, will assure that you will be able to maintain system
reliability and availability.

Field Service engineering on-site support is available, depending on the product
and location, from one of our Full-Service Distributors. The field engineers are
experienced both on Woodward products as well as on much of the non-
Woodward equipment with which our products interface.

For information on these services, please contact one of the Full-Service
Distributors listed at www.woodward.com/directory.

Contacting Woodward’s Support Organization

For the name of your nearest Woodward Full-Service Distributor or service
facility, please consult our worldwide directory published at
www.woodward.com/directory.

You can also contact the Woodward Customer Service Department at one of the
following Woodward facilities to obtain the address and phone number of the
nearest facility at which you can obtain information and service.

Products Used In
Electrical Power Systems

Products Used In
Engine Systems

Facility Phone Number  Facility Phone Number
Brazil ------------- +55 (19) 3708 4800 Brazil ------------- +55 (19) 3708 4800
China ----------- +86 (512) 6762 6727 China----------- +86 (512) 6762 6727
Germany: Germany ------ +49 (711) 78954-510

Kempen----+49 (0) 21 52 14 51  India --------------- +91 (129) 4097100

Stuttgart - +49 (711) 78954-510 Japan--------------- +81 (43) 213-2191
India --------------- +91 (129) 4097100 Korea--------------- +82 (51) 636-7080
Japan--------------- +81 (43) 213-2191  The Netherlands--+31 (23) 5661111
Korea--------------- +82 (51) 636-7080 United States-----+1 (970) 482-5811
Poland -------------- +48 12 295 13 00

United States-----+1 (970) 482-5811

Products Used In
Industrial Turbomachinery

Systems
Facility Phone Number
Brazil ------------- +55 (19) 3708 4800
China----------- +86 (512) 6762 6727
India --------------- +91 (129) 4097100
Japan--------------- +81 (43) 213-2191
Korea--------------- +82 (51) 636-7080
The Netherlands--+31 (23) 5661111
Poland -------------- +48 12 295 13 00

United States-----+1 (970) 482-5811

For the most current product support and contact information, please visit our
website directory at www.woodward.com/directory.
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Technical Assistance

If you need to contact technical assistance, you will need to provide the following information.
Please write it down here before contacting the Engine OEM, the Packager, a Woodward
Business Partner, or the Woodward factory:

General
Your Name

Site Location

Phone Number

Fax Number

Prime Mover Information

Manufacturer

Engine Model Number

Number of Cylinders

Type of Fuel (gas, gaseous, diesel,
dual-fuel. etc.)

Power Output Rating

Application (power generation, marine,
etc.)

Control/Governor Information
Control/Governor #1

Woodward Part Number & Rev. Letter

Control Description or Governor Type

Serial Number

Control/Governor #2

Woodward Part Number & Rev. Letter

Control Description or Governor Type

Serial Number

Control/Governor #3

Woodward Part Number & Rev. Letter

Control Description or Governor Type

Serial Number

Symptoms
Description

If you have an electronic or programmable control, please have the adjustment setting positions or
the menu settings written down and with you at the time of the call.
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Send comments to: icinfo@woodward.com

Please reference publication 36752.
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1000 East Drake Road, Fort Collins CO 80525, USA
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Email and Website—www.woodward.com

Woodward has company-owned plants, subsidiaries, and branches,
as well as authorized distributors and other authorized service and sales facilities throughout the world.

Complete address / phone / fax / email information for all locations is available on our website.
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